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The following pertains to any software of CE Software’s licensor(s) included with this software package:

CE SOFTWARE’S LICENSOR(S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING THE SOFTWARE.  CE SOFTWARE’S LICENSOR(S) DOES NO
WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELI-
ABILITY, CURRENTNESS OR OTHERWISE.  THE ENTIRE RISK AS TO THE RESULTS AND PERFOR
MANCE OF THE SOFTWARE IS ASSUMED BY YOU.  THE EXCLUSION OF IMPLIED WARRANTIES IS
NOT PERMITTED BY SOME JURISDICTIONS.  THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL CE SOFTWARE’S LICENSOR(S), AND THEIR DIRECTORS, OFFICERS, EMPLOY
EES OR AGENTS (COLLECTIVELY CE SOFTWARE’S LICENSOR) BE LIABLE TO YOU FOR ANY CON
SEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE 
LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF CE SOFTWARE’S
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSE-
QUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO  YOU.  
CE Software’s Licensor’s liability to you for actual damages from any cause whatsoever, and regardless o
form of the action (whether in contract, tort [including negligence], product liability or otherwise), will be li
ited to $50.

This CE Software publication was created electronically using Adobe® FrameMaker® on the Apple® 

Macintosh®.

Art was produced using Adobe Photoshop®. 

Additional design by Lessing-Flynn Advertising Company.

Printed by Acme Printing Company, Inc.

Apple, AppleScript,  and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and o
countries. 

Photoshop®  is a registered trademark of Adobe Systems, Inc.
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WELCOME TO QUICKMAIL PRO

Welcome to the world of electronic mail. The people at CE Software are confident that you will fin
QuickMail Pro an indispensable communication tool. With its intuitive interface, speedy operation
robust feature set, QuickMail Pro is an ideal choice for both business and personal use. 

QuickMail Pro is based on the open standards of the Internet. You can retrieve your E-mail from 
location worldwide as long as you have a computer running QuickMail Pro and an account on a 
that supports Post Office Protocol (POP3).

PRODUCT FEATURES

The Version 2 release of QuickMail Pro includes the following features and enhancements, addin
nificant improvements to an already capable and thoroughly practical product.

■ User configurations entered on a QuickMail Pro Server can be automatically transferred 
each client, greatly simplifying the mail system setup.

■ Shared mailboxes allow workgroup members or individuals on a project team to access a
inbox (sometimes referred to as a public folder).

■ Improved search capabilities, mail filtering, and folder organization make it easy to sort y
mail, track down previous message information, and store important messages.

■ Mail users can adopt multiple identities, called personas; different personas can help org
communication tasks conveniently and let you present yourself to the world in a specific 

■ Extended directory service support simplifies retrieving E-mail addresses from external 
directory servers. Close integration with the QuickMail Pro Directory System ensures tha
contact data can be rapidly distributed and updated for all QuickMail E-mail clients.

■ Selective filtering of address book data lets you quickly locate key information and hide 
irrelevant details.

■ The streamlined mail management tools and intuitive interface let you handle all your 
incoming messages efficiently. You can watch QuickMail Pro access all your E-mail acco
from a single Message Browser window.

■ QuickMail message forms let you personalize communication. You can choose from more
a dozen installed forms or create your own. 

■ The Message Peek feature lets you preview and display the contents of each message, 
you locate information and decide which messages to answer. 

■ Flexible enclosure handling helps eliminate problems when sending files to other E-mail u
You can send attachments that match each recipient’s computing environment — Macint®, 
Windows® and UNIX®. After specifying the criteria for a user in the address book, the corre
file transfer format is selected automatically for each message.
ix
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ABOUT THIS MANUAL

This documentation assumes you are familiar with Macintosh hardware and the Mac OS. If you n
assistance with standard Macintosh procedures, consult the documentation that came with your 
tosh user handbook.

CONVENTIONS

Different fonts and styles are used in this manual to make instructions more clear:

■ Helvetica Condensed font to indicate menu options, buttons and active dialog text. For 
example: Go to the File menu.

■ Gill Sans Bold font to indicate typed text and Uniform Resource Locators (URLs) for Wor
Wide Web pages. Example: http://www.cesoft.com.

■ Times Italic font for emphasis. Example: Do not restart your machine.

■ Colons to indicate folder and file hierarchy. Folder pathnames end with a colon. For exam
the application is stored in the <hard drive>:System Folder:CE Software:QuickMail Intern
folder. File pathnames do not end with a colon. For example, launch the <hard 
drive>:QuickMail Pro:Tutorial to learn more about QuickMail Pro Server.

■ Variable text or values are enclosed in angle brackets. For example, 
<yourcompany@domain.com>.

ICONS

Icons are used to draw attention to significant points in the documentation. The icons used includ

❖ Indicates a Note

➣ Indicates an Important point

▲ Indicates a Warning
x Preface
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CONTACTING CE SOFTWARE

If you have questions about the QuickMail Pro that are not addressed in this manual, this section
vides contact information for reaching CE Software™.

TECHNICAL SUPPORT

CE Software offers online, fax, and telephone support. Visit the Technical Support Web page at 
http://help.cesoft.com for information about the various support options.

CONTACT INFORMATION

The Technical Support Department is available Monday through Friday from 8:00 A.M. to 5:00 P
Central Time. CE Software Technical Support can be reached by:

■ Phone: 515-221-1801 or 800-579-9730

■ Fax: 515-221-1806

■ Web page: http://help.cesoft.com/ 

■ E-mail: ceonline@cesoft.com

BEFORE YOU CALL

Check the CE Software Web site for updates and product information at http://help.cesoft.com/.

WHEN YOU CALL
To help our Technical Support team assist you as quickly as possible, please have the following 
mation available when you speak with, or write to, a Technical Advisor:

■ Product name and version (for example, QuickMail Pro Server, version 2.0)

■ Computer type and model (for example, Macintosh G3)

■ Operating system and version (for example, Mac OS 8.5)

PRODUCT FEEDBACK

What do you think of QuickMail Pro? We want to know and we encourage you to submit your ide
feedback@cesoft.com so we can consider them for the next version of QuickMail Pro.
Welcome to QuickMail Pro xi
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USER MANUAL FEEDBACK

We also welcome feedback about the documentation that accompanies QuickMail Pro. Please E-
at manuals@cesoft.com with your comments and suggestions.

The most current version of this manual is available online at http://www.cesoft.com/ and can be 
viewed with Adobe® Acrobat Reader 3.0 or greater. Visit http://www.adobe.com/ to download a free 
copy of Acrobat Reader.

SALES AND CUSTOMER SERVICE 

CE Software’s Sales and Customer Service staff can answer your questions about product availa
upgrades, product prices, damaged discs, customer registration, and general policies.

CONTACT INFORMATION

The CE Software Customer Service department is open Monday through Friday from 8:00 A.M. to 
5:00 P.M. U.S. Central Time. If you have a question about your CE Software product, please have
serial number ready when you call. For customers outside the U.S., please call your local distribu

■ Phone: Domestic orders: 800-523-7638

■ International orders: 515-221-1801

■ Fax: International and Domestic orders: 515-221-2258

■ Online: http://www.cesoft.com/service/cshome.html

OWNERSHIP TRANSFER

If you transfer ownership of a CE Software product, please E-mail us at sales@cesoft.com or send a 
letter with the product name, serial number, your name and the new owner’s name and address 

CE Software, Inc.
Attn: Ownership Transfer
P.O. Box 65580
West Des Moines, IA 50265 U.S.A.

CHANGE OF ADDRESS

If you change your address, please send a letter indicating your old and new address to:

CE Software, Inc.
Attn: Change of Address
P.O. Box 65580
West Des Moines, IA 50265 U.S.A.
xii Preface
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CHAPTER 1: INTRODUCTION TO QUICKMAIL PRO

QuickMail Pro sets new standards for personal and business communication with an E-mail appl
designed to fit your work habits. From its innovative Contacts Manager to its intuitive Message 
Browser, QuickMail Pro can help you organize your E-mail communication, even if you handle do
of messages a day. QuickMail Pro’s close integration with LDAP directory services, including the
QuickMail Pro Directory System, lets you keep your address book up to date and helps you loca
tacts across the Internet.   

This chapter offers an introduction to QuickMail Pro, describing the most important features and 
marizing the different ways this application can be custom tailored to your personal requirements
you have not yet installed the software, complete the installation while referring to the Getting Started 
guide, included in the product package. If your E-mail account will be hosted on a computer runn
QuickMail Pro Server software, talk to your administrator, who will assign you a password for you
tial access to the program. Once logged in, you can change your login password and change the
words to other E-mail accounts you may have, if your ISP or mail system server account support
remote password changes. For more information about the underlying QuickMail Pro architecture
to “How QuickMail Pro Works” on page 133.

TYPES OF INTERNET CONNECTIONS

❖ Note: You do not need an Internet connection if your mail system will be hosted on an intrane
QuickMail Pro Server. 

QuickMail Pro users who are on a network that includes QuickMail Pro Server can let the server
most of the configuration work. If the server administrator has already set up user accounts and a
passwords, you can automatically configure your mail client by selecting the automatic configura
option.

You can also install and configure the application manually to suit your preferences. QuickMail Pr
be used to access mail from a mail system serviced by QuickMail Pro Server or as a standalone
designed to retrieve mail from any POP3 server in the world on which you have an account. 

The information required to set up QuickMail Pro depends on the type of Internet connection tha
plan to use. Two types of Internet connections are commonly available:

■ Transient connections (sometimes called dial-up connections). With this type of connecti
you reach the Internet by dialing a number using your computer’s modem. The connectio
called transient because it is only available when you make an external phone call. 

■ Direct connections. With this type of connection, your computer has continuous Internet a
through your organization’s local area network or through a dedicated line. 
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TRANSIENT CONNECTIONS

If you have a transient connection to the Internet, you will need some information from your ISP, 
including:

■ The SMTP host address.

■ A POP account name.

■ A POP account password.

■ A POP server address.

■ A phone number to the POP server.

■ A Domain Name Server (DNS) address.

Figure 1: Exchanging E-mail through an ISP

Internet Recipient’s POP 
server at ISP

Modem Connection

Sender Recipient

Simple Mail Transfer Protocol (SMTP)

PPP 
Connection

Modem Connection

PPP 
Connection

Sender’s SMTP 
server at ISP
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DIRECT CONNECTIONS

If you have a network connection to the Internet, you need:

■ The SMTP host address.

■ A POP account name. 

■ A POP account password.

■ A POP server address.

 

Figure 2: Exchanging E-mail through a direct network connection

❖ Note: For both transient and direct connections, you need TCP/IP networking software install
the computer used for E-mail.

LOGGING IN TO QUICKMAIL PRO

QuickMail Pro is designed to support multiple E-mail users, each working on a single computer. 
though one copy of the application may provide E-mail access to several persons, each person’s
sonal data and E-mail is hidden and protected from other users by a password. Each time you lo
QuickMail Pro, the application asks for your password. The initial login password opens your use
account and lets you retrieve new E-mail or browse earlier messages. This password may also u
message retrieval from more than one E-mail account, each with its own password. QuickMail P
automatically supply the necessary password to retrieve mail from each account, or you can set 
require that the password for each E-mail account be typed in manually when you check mail. In
words, once you log in to QuickMail Pro, you can have the application supply the passwords for e
your E-mail accounts. This lets you quickly access all of your mail, without typing in passwords o

Simple Mail Transfer Protocol (SMTP)

RecipientSender

Sender’s SMTP server Recipient’s POP server Internet

TCP/IP 
ConnectionTCP/IP 

Connection
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and over. To keep your E-mail accounts secure, always keep your primary login password private
also recommend that you change your password on a regular basis, perhaps once a month. For
details about setting individual E-mail account passwords, refer to “Accounts” on page 87.

Typically, when you receive a password and account name from the administrator of QuickMail P
Server, the password may be a cryptic combination of letters and numbers, automatically genera
the server. For example, the password shown in Figure 3, u87t5roq, might initially apply as both the pri-
mary login password and the QuickMail Pro E-mail account password. You can change the login
word to something easier to remember (in the example, the word dandelion). QuickMail Pro can be 
configured to automatically supply the passwords for one or more actual E-mail accounts, so tha
you log in, you can access all of your E-mail accounts without typing in additional passwords. Yo
also configure the program to bypass the login screen completely, so you never have to enter an
words. 

Figure 3: Login password compared to E-mail account passwords

Initial password is the same for your 
primary login and your 
QuickMail E-mail account

Login Password: u87t5roq QuickMail E-mail account: u87t5roq

QuickMail E-mail account: u87t5roq

Login Password: dandelion

You can change your login password 
and still access E-mail accounts with 
different passwords

Other E-mail account: darktower

E-mail account passwords are 
separate from the login password

Once you enter your login 
password, QuickMail Pro 
can supply passwords for 
each E-mail account
4 Chapter 1
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 ACCESSING QUICKMAIL PRO

QuickMail Pro preserves your account information in a “QuickMail Users” list. The application rem
bers the last user who logged in; if you are a different user, use the Change User button to select your 
name from a list.

1 Select QuickMail Pro in the Apple (a) menu. The QuickMail Login dialog appears.

Figure 4: QuickMail Login

2 If your name is not displayed in the login screen, use the Change User button to access the list of 
QuickMail users who have logged into their accounts from your computer. 

Figure 5: QuickMail Users list

3 Select your name from the list, or, if this is the first time you have used the application, click 
Add New button to activate your account. Follow the onscreen instructions to select a server an
auto-activation to set up your account.
Introduction to QuickMail Pro 5



words 

of the 
at this 

re 
 one of 

e 

 the 
4 From the login dialog, type your assigned password. The administrator usually supplies pass
for each user.

5 Leave Online selected if you have a permanent network connection, or select Offline if you connect to 
the Internet through a dial-up connection.

6 Click Login to complete the login operation.

Refer to “QuickMail Pro Options” on page 80 for information on bypassing the login screen.

CHANGING YOUR LOGIN PASSWORD

Your login password is initially the same as the main user account. To personalize the operation 
program, you can change this password to one that is easy for you to remember. Keep in mind th
login password controls access to QuickMail Pro, but does not affect any other passwords that a
required to access individual E-mail accounts. To change a password on the server that is hosting
your E-mail accounts, refer to “Changing a Server Password” on page 7. 

To change your login password:

1 Launch QuickMail Pro. The login dialog appears.

2 Select the Set Password button on the login dialog. The Change Login Password dialog appears.

Figure 6: Changing your login password

3 Enter your current password in the Current Password text box. For new accounts, this password is 
generally assigned by the administrator.

4 Enter the New Password that you want to use to log in to your account and confirm the entry in th
Verify Password text box. 

5 Click Change to complete the password modification. QuickMail Pro recognizes this password
next time you log in to the application.
6 Chapter 1
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SETTING UP MULTIPLE USERS ON ONE COMPUTER

If more than one person uses your computer, you can create additional users using the following

1 Launch QuickMail Pro.

2 Select the Change User button in the Login dialog.

3 Select the Add New button in the QuickMail Pro Users dialog. 

4 Complete the series of Account Assistant screens that appear. These screens are explained in theGet-
ting Started guide. Optionally, you can use the auto-activation feature to let a QuickMail Pro Se
configure your account information.

Whenever you launch QuickMail Pro after creating multiple accounts, the name of the user who 
last logged in from that machine displays in the Name field. If you were not the last user to login, use th
Change User button and then select your name from the user list.

❖ Do not confuse the process of setting up multiple users on one computer with the process of 
up one account with multiple personas. While this section discusses setting up multiple user
page 87 discusses setting up multiple personas.

CHANGING A SERVER PASSWORD

Each account that you set up in QuickMail Pro can access an E-mail account using a different se
password. If you want to change an existing password, QuickMail Pro’s Change Server Password dialog 
enables you to change your account password from any client machine that runs QuickMail Pro 
accesses a POP3 server. To change your password:

1 Select Change Server Password from the Configure menu. The Change Server Password dialog appears.

Figure 7: Change Server Password dialog
Introduction to QuickMail Pro 7
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2 Select the account name for which the password applies. If you have more than one accoun
sure that you choose the correct account that is set up for the server on which you want a di
password (you can refer to the Account information, as described in “Accounts” on page 87, 
ify these details).

3 Enter the Current Password followed by the New Password.

4 Retype the New Password in the Verify Password text box to ensure that it was correctly entered.

5 Click Change. The status of your changes appears above the buttons in the Change Server Password 
dialog. Click Stop if you wish to abandon a change that is in progress.

6 Close the dialog when the status area of the Change Password dialog reports a successful password
change. This password will be automatically supplied when you access this E-mail account, 
have selected that option in your Preferences. Otherwise, you must manually enter the pass
when you retrieve messages from the selected E-mail account.

➣ IMPORTANT : The status area of the Change Password dialog may report that changing your password
was unsuccessful if you typed incorrect information, your ISP or administrator turned off remote 
password changing on the server, or if your POP3 server does not support remote password cha

NAVIGATING IN QUICKMAIL PRO

QuickMail Pro offers two primary views of the messages and contact data associated with your E
account. 

■ The Message Browser provides a view of the messages in the various folders that you use
mail storage. You can sort and display messages in many different ways, and also searc
content in archived messages if they are stored in your local folders. 

■ The Contacts Manager controls access to the database in which your address books are s
and also provides a link to LDAP directory services, allowing you to search for an individu
address through participating directory servers. 

You can easily navigate between the Message Browser and the Contacts Manager. While addres
message, QuickMail Pro lets you jump to the current address book through the Contacts Manag
select one or more recipients for your message. While sorting through the contents of an addres
you can select a recipient and click a button to begin composing a new message. The manner in
these two different views of your E-mail information work together is discussed in more detail in l
chapters in this manual; this brief introduction should familiarize you with the basic concepts.
8 Chapter 1
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MESSAGE BROWSER VIEW

The Window menu in QuickMail Pro lets you open the Message Browser and Contacts Manager windows. 
While in the Message Browser window, shown in Figure 8, you have a variety of ways to view, sor
manage E-mail messages that have been received. You can also quickly open a window to comp
new message by clicking the New button on the button bar. Some of the buttons along this button ba
support drag-and-drop operations. For example, you can drag an individual message from the lis
appearing in the Message Browser and drop it on the File button. QuickMail Pro displays a dialog that 
lets you choose a folder in which to file the message. You can also freely move messages betwe
different folders shown in the Message Browser. For example, you can drag a message from theInbox 
folder and deposit it in the My Filed Mail folder for later access. The Message Browser folder contents 
be displayed or hidden using the arrows along the left side of the window. 

You can also make selections to filter the display of messages using the Show options that can be entered
on the Filter bar. For example, you might choose to Show all messages containing the terms “fire drill.” 
QuickMail Pro sorts through the collection of stored messages and modifies the list of messages t
only those that contain those two terms. Being able to filter the message display in this manner le
easily sort and identify specific messages even if you have hundreds of messages stored on you

The Contacts button lets you jump to the current address book or directory server entries. There are
ways to jump to a display of address book entries, including composing a message and attempti
send it without filling in a recipient. QuickMail Pro is designed to anticipate the tasks you are atte
ing to perform, automatically displaying the dialog or window that next needs to be completed. 
Introduction to QuickMail Pro 9
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Figure 8: The Message Browser view

CONTACTS MANAGER VIEW

The Contacts Manager controls the display of address books and directory server lists to assist y
selecting recipient for messages and searching for contact data. The directory service capabilitie
QuickMail Pro offer a valuable search tool that can retrieve not only E-mail addresses of organiza
and persons, but additional information, such as telephone numbers, street addresses, organiza
affiliations, and so on. 

❖ Note: The amount of information that you can access through directory services depends on 
data that a person or organization has decided to make public.

The Contacts Manager remembers the last selection you made when addressing a message, and
the appropriate data the next time you access an address. For example, if you used the QuickMa
Directory System to look up a name while addressing a message, the Contacts Manager access
same Directory System that next time you access it. Similarly, it remembers the last address boo
you had open and returns to that address book when you select it again, as shown in Figure 9.
10 Chapter 1
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Figure 9: The Contacts Manager view

The tabbed dividers along the upper edge of an open address book let you quickly jump to an alp
listing, sorted by First Name, Last Name, or Organization, according to the sorting selections you
at the bottom of the Contacts Manager window. You can also control the amount of detail display
the window using the icon selections on the bottom row. For example, you can selectively display
E-mail fields, phone numbers, and organizations by choosing the appropriate icons. 

If you identify a person or several people that you want to send a message to, you can drag each
icon over to the TO button in the upper right corner of the window. The Contacts Manager opens a 
message window and you can immediately beginning composing the message. 

The procedures in Chapters 2, 3, and 5 explain the different ways in which the Message Browse
Contacts Manager interact. As you become more familiar with QuickMail Pro, you will probably 
develop your own favorite shortcuts for composing and handling mail. 
Introduction to QuickMail Pro 11
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CHAPTER 2: SENDING MAIL

This chapter explains how to compose messages, create Address Books and Groups, send encl
check spelling, edit dictionaries, and stylize text.

USING THE MESSAGE BROWSER

The Message Browser, shown in Figure 10, serves as QuickMail Pro’s control center. Messages
sent, received, sorted, filed, printed, read, and created. The browser window, where you will spend
of your time while using the program, can be customized to suit your preferences. Messages can
sorted and displayed in a variety of ways, using a nested folder approach similar to the Finder in
Mac OS. 

To reduce the volume of messages you view at one time, and to access your mail in an organize
ner, you can filter the messages that are displayed. Filters can be applied to viewing any of the fo
available for message storage, including the Inbox, Outbox, Sent Mail, Personal Folders, and so o
can handle the incoming mail according to your personal work habits and needs. The buttons alo
top of the Message Browser offer quick access to many of the same tasks that appear in the pro
menu options. Incoming mail messages appear first in the Inbox folder, shown in Figure 10, wher
can then be handled in a number of ways.

Figure 10: Message Browser window

Unread mail

Read mail

Filter options

Personal folders

Your main POP account
Click the banner to visit 
CE Software’s Web site.

Button bar

Connection status

Outgoing mail

Message peek

Messages are sorted by the 
highlighted 
column heading.
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VIEWING HOT HELP

Many of the buttons and icons throughout QuickMail Pro are equipped with Hot Help interactivity
you place the mouse cursor over an item, such as a button on the button bar, a brief description 
item appears in a pop-up box. Hot Help serves as a quick reminder of the controls that you have
able while using the application. Hot Help message can appear immediately or after a delay that 
in the Display panel under Preferences, as described in “Display” on page 82.

Figure 11: Hot Help on the button bar

CREATING AND SENDING A MESSAGE

QuickMail Pro lets you compose messages whether you are online or offline. You can either send
message immediately or delay the send if you use QuickMail Pro Server as your mail server.

To create a message:

1 Launch the QuickMail Pro application from its folder, from the Apple menu, or from the QM P
Menu. Enter your assigned username and mail password when the Login screen appears. 

❖ Note: If QM Networker is running, you can use the default hot-key combination, c-Ctrl-Q, to 
launch QuickMail Pro. Refer to the preferences settings described in “System” on page 80 to
change the hot-key combination.

2 Select New in the File menu and then choose Message to display a new message window.

3 Type the E-mail address of the recipient into the To field (directly below the Sender field). Clicking 
the Receipt icon at the end of the line, so that a check mark appears beside it, ensures that a
will be requested when the message is delivered or read, depending on how your preference
set. An “X” by the Receipt icon indicates this feature is not enabled.

❖ Note: If the recipient exist in an address book for which “Tab completion” is enabled, you can b
typing the name and QuickMail Pro will auto-fill the To field with potential name matches.

4 Enter a Subject for the message onto the Subject line (as shown in Figure 12).

5 Type the message contents into the Message body area of the form. You can also select a d
form for the message from the options available through the Form drop-down list.

■ Press the Tab key or use your mouse to move between fields on the form. 

Hot Help pop-up
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Figure 12: The Message Window

6 Click the Send button. 

❖ Note: If you did not choose a recipient for the message, QuickMail Pro automatically displays
current address book to let you choose the recipients. You can drag selected entries from the
alphabetically indexed address book to the TO:, CC:, and BCC: fields. Click OK when done. Click the 
Delay button to send the message at a specific time and date (this only works with the QuickMa
Server). Choose the delivery time and date in the dialog that appears. The Send button transfers the 
message to the indicated recipients at the next scheduled connection. You can also access t
dialog by clicking the Show Address Dialog icon to the left of Sender field.

Enter an address in the To 
field. For multiple addresses, 
put each entry on a separate 
line.

Subject line

Message body

Size the Address pane of the 
Message window by clicking 
and dragging the bottom line 
of the address box.

Select the Receipt icon to re-
quest a return receipt when 
the message is 
delivered or read.

Select the Contacts button to 
open an address book to se-
lect recipients.
Sending Mail 15
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Figure 13: Main Address Book

7 Your message is stored in the Outbox until the next scheduled mail delivery time arrives or u
you select one of the menu options that transmits mail during a connection (such as Check and Send 
All Accounts under Send & Receive in the File menu). If you have chosen to schedule delivery, the m
sage is sent from the Outbox at the time you have specified (refer to “Scheduling Your Conn
tions” for more details).

❖ Note: The time of your next connection displays in the Connection Status portion of the Message 
Browser.

SCHEDULING YOUR CONNECTIONS

To schedule your connection intervals:

1 Select Preferences in the Configure menu.

2 In the User panel, select the Accounts option.

3 Double-click the account you want to edit. 

4 Click the Edit button to access the account information. The Edit Account dialog appears.
16 Chapter 2
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Figure 14: Setting the interval to check mail

5 In the Incoming Mail options, check the box labeled Check mail... and enter the number of minutes 
between connections. 

6 Click OK to save the new values. 

After the mail is sent to the SMTP server, the message is stored in the Sent Items folder. 

❖ Note: To send mail immediately, select Send All Accounts in the File menu or press uc-K.

USING QUICKSEND

Use QuickSend when QuickMail Pro is not launched and you need to send an E-mail message q
For example, if you are working in Microsoft Word™ and you want to send a message to a business p
ner:

1 Select c-Ctrl-S (or the HotKey combination you have assigned) to open the QuickSend form.

➣ IMPORTANT : The QM Networker must be launched and you must be logged in to QuickMail Pro
the QuickSend hot-key combination to work.

2 Type and address your message. See“Addressing Messages” on page 20.

3 Click Send.

The E-mail message is immediately delivered to your contact at the stroke of a key. 

After you click Send, the QuickSend form closes and the focus returns to your Microsoft Word doc
ment.
Sending Mail 17
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ASSIGNING A MESSAGE PRIORITY

Each message that you create can be assigned a priority, which generates a flag that appears in 
ferent E-mail client applications (including QuickMail Pro). The flag helps the message recipient 
quickly identify messages of particular types, especially if a message is Urgent. 

To assign a message priority:

1 Compose a new message.

2 Address the message to the intended recipient.

3 Click the priority button located to the right of the message address field, as shown in Figure
and select one of the three options: Urgent, Normal, or Bulk.

Figure 15: Message priority options

4 Use the Send button to route the message to the Outbox.

USING RETURN RECEIPTS

The Return Receipt option requests a receipt. The user’s preferences determine whether the rec
returned when the message is delivered to the recipient, when the message is opened by the rec
both. Keep in mind when requesting a receipt that the recipient may elect not to return receipts o
recipient’s server may not respond to receipt requests. More information about setting receipt pre
ences appears in “Return Receipts” on page 95.

If you are sending important documents across the Internet, this feature helps confirm that mess
reached their intended destinations. Return receipts are displayed in the Receipts folder, as show
Figure 16, with an indication of whether the delivery was successful or whether delivery problems
encountered. Double-click a Return Receipt entry for more information about the status of the me
delivery.
18 Chapter 2
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Figure 16: Return receipts

➣ IMPORTANT:  You only receive a Return Receipt if the recipient’s E-mail software and mail serve
support this feature. This feature is generally supported by most modern E-mail applications.

BAD ADDRESS NOTIFICATION

If the SMTP server to which you are connecting supports address validation, the mail system no
you immediately if you have used a bad address in an outgoing message. A regular message ico
appears in your Outbox with a red exclamation box above it. If you see this icon, open the messa
check the addresses. Each bad address will have a red exclamation box next to it.

If your server does not support address validation, messages with bad addresses are sent out an
returned to your Inbox with an undeliverable stamp.

UNSENDING MESSAGES

If you have sent someone a message by mistake and you catch the error before the person has 
message, you can unsend that message.

To unsend a message:

1 Open the Sent Items folder in the Message Browser.

2 Select the message you want to unsend and select Unsend from the Message menu. The instruction to 
unsend the selected message appears in your Outbox.

3 Click the Check Mail button in the Message Browser to immediately submit your request to uns
the selected message.

4 The next time you check mail, a message appears in your Return Receipt folder indicating w
your request to unsend the message succeeded or failed. Unsend requests are successful a
the message is still on the server at the time of the Unsend request. See Figure 17 for an illu
of a message that was sent in response to an unsend request.
Sending Mail 19
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Figure 17: An unsend receipt for multiple recipients

➣ A successful unsend receipt means that the mail message has been deleted from the recipient’s
on the server. If the recipient of the unsent message uses the Leave Mail on Server option, it is not possible 
to determine whether or not the message has been downloaded to a client workstation, even tho
Return Receipt may report that the unsend request has been successful.  

ADDRESSING MESSAGES

There are three ways to address a message:

■ Type the address into the TO: entry field of a message form (the “To” only appears after you
begin entering an address in the field).

■ Click the Contacts button or the Show Address Dialog button in a message window to access the
current address book or directory server contents.

■ Click the Send button in a message form to choose your contacts from a list appearing in t
current address book or selected directory server. 

❖ Note: When sending messages to users who are on the same server, you can address mess
account name such as (e.g. joe.cool) instead of typing the full E-mail address (e.g. 
joe.cool@cesoft.com). 
20 Chapter 2
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TYPING THE ADDRESS

If you want to send E-mail to someone you communicate with infrequently, you can enter their ad
directly into QuickMail Pro’s address pane. In the Message window, click the dimmed text area o
address pane that says “<Click here to add a new recipient>”. Type the recipient’s E-mail addres
directly into the text box that appears. By default, a To drop-down arrow appears to the left of the E-ma
address you type. You can change this setting by selecting Cc or Bcc from the drop-down menu. 

To enter multiple addresses. put each entry on a separate line. Press the Tab or Return keys to m
the next line of the Address pane and add more recipients. The message is formatted as MIME a
message attachments are encoded using AppleDouble unless you specify a different form of enc
See “Setting Mailer Encoding Preferences” on page 24 for information on changing the default m
tings.

❖ Note: You can also drag an entry from an open address book to the message’s address pane
complete the addressing of a message.

TYPE TO FEATURE

When you start entering an address in the To field, QuickMail Pro tries to find a match in the Contact 
Manager database and displays the most likely choices based on the characters you have entere
If more than one match is identified, the program displays <Multiple matches found>, To sort thro
the list of potential recipients, press Return and QuickMail displays the list of multiple matches, a
ing you to select one. Or, you can keep entering characters. When you see a match that identifie
recipient exactly, press Return to add the name to the address pane.

USING THE SHOW ADDRESS DIALOG

1 Click the New Message button in the Message Browser. 

2 Click the Show Address Dialog icon (the small face to the left of the address header). The current
address book appears (showing the last address book accessed or the directory server last 
tacted). This dialog also appears if you click the Send button without having added recipients to th
address pane of the message.
Sending Mail 21
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Figure 18: Selecting contacts from the address book

3 If the current address book or directory server is not the one that you want to view, make a n
selection by clicking the Address Books or Directory Servers buttons in the upper left portion of the 
window. 

4 Identify recipients from the list, using the tabbed letters to display the starting letter to include
the alphabetic list. You can sort entries by First Name, Last Name, or Organization by choos
item from the Sort By drop-down list. You can add data fields or remove them from the display u
the row of icons just below the data pane.

5 Choose recipients from the list in one of these ways:

■ Highlight the name and double-click it. The name appears in the TO: pane.

■ Highlight the name and click the TO:, CC:, or BCC: button at the top of the window to copy the 
name and address to the corresponding pane. 

■ Drag the icon for the person to the TO:, CC:, or BCC: button at the top of the window. The name
is copied to the appropriate pane. 

■ Drag the icon for the person to the appropriate pane on the right: TO:, CC:, or BCC: The 
and address are copied over.

6 You can move recipients between the TO:, CC:, and BCC: panes, as needed, or delete a name by hi
lighting it and clicking the Trash button in the upper right corner of the window. You can also dra
name to the Trash button to remove it.

Selects a different 
address book

Selects a directory 
server

Use these icons to choose 
which data fields are displayed

Sort entries by first name, last 
name, or organization
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7 When you have completed filling in the address panes, click Send to route the message to the indi-
cated recipients at the next scheduled connection. Choose Delay to send the message according to
specific schedule and complete the dialog that appears.

❖ Note: To add contacts to an address book or to modify data, use the Contacts Manager, as de
in “Working with Address Books in the Contacts Manager” on page 28.

DELAYING MESSAGE DELIVERY

You can delay sending messages using the Delay feature or the Drafts folder. The Delay feature i
when you are finished composing a message, but don’t want to send it until a specific date and tim
Drafts folder is useful when you haven’t finished composing a message that you eventually want
send.

USING THE DELAY FEATURE

➣ IMPORTANT : Delayed message delivery is only available if your mail server is QuickMail Pro Se

From the Show Address dialog, you can complete the address panes required for a message. If y
to delay the message delivery until a later time, use the Delay button to select a time.

To delay message delivery until a specific date and time:

1 Complete a new message and then select the Show Address Dialog button.

2 Select the recipients for the message and then click the Delay button. The Delay Send dialog appears.

Figure 19: Delay Send dialog

3 Select a date using the Do not deliver message until field.

4 Choose a time for the message delivery.

5 Click OK to confirm your choices. QuickMail Pro completes the message delivery according t
schedule you have selected.
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USING THE DRAFTS FOLDER

The Drafts folder is visible in the Message Browser view. When you are composing a lengthy me
or when you run out of time composing a message, you can store those incomplete messages in
Drafts folder until you are ready to finish them. 

To delay message delivery until you can complete the message, you can click the close box in a
ished message and click the Save button at the prompt, the message is automatically placed in the Dr
folder. 

You can also use the following steps as an alternative method of storing messages in the Drafts 

1 Create a message and begin typing in the subject line and body of the Message window tha
appears.

2 Click the Save As Draft button in the Message window. The incomplete message is immediately
saved to the Drafts folder. Open the message and begin typing when you are ready to finish

THE TEMPLATES FOLDER
By default, the Drafts folder contains a Templates folder that stores message templates. When yo
a message in the Templates folder, the text, style, and form used in that message is automatical
able to you when you click and hold the New button in the Message Browser. This capability enables y
to compose messages more quickly because you can use existing information from a stored tem

To create a template:

1 Create a message and begin typing in the subject line and body of the Message window tha
appears. For example, type the information you normally provide for your weekly report.

2 Click the Save As Draft button in the Message window. The “canned” message is immediately sa
to the Drafts folder.

3 Open the Drafts folder and drag your message to the Templates folder.

4 Click and hold the New button in the Message Browser. The message you just 
placed in the Templates folder appears in the pop-up window that displays. 
The shortcuts that appear next to each template can be used to launch a partic-
ular template with a keystroke. 

To remove a template from the Templates folder, simply drag it out to the main level of the Drafts 

SETTING MAILER ENCODING PREFERENCES

QuickMail Pro offers considerable flexibility in determining how encoding options are handled. To 
the current preferences for the Mailer Encodings, select Preferences from the Configure menu and high-
light the Mailer Encodings item in the Advanced panel. The currently assigned mailer encodings are dis-
played.
24 Chapter 2
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Figure 20: Preferences dialog

For each of the different platforms, the capabilities column lists the characteristics of messages a
encoding for that platform. For example, for QuickMail messages, QuickMail Forms can be used
message body is composed in plain text, and BinHex 4.0 is used for encoding attachments.

The mailer encodings shown will work in the vast majority of situations, but you have the option o
ing the characteristics of any of the listed selections. Highlight the platform in the Mailer Encoding col-
umn and click Edit. The Edit Mailer Encoding dialog appears.

Figure 21: Edit Mailer Encoding dialog
Sending Mail 25
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You can individually set the Forms selection, the Text Encoding method used, and the Attachment Encoding 
through this dialog. QuickMail Pro also supports the creation of additional Encoding Names. You
define a custom encoding method by assigning a name and selecting appropriate values for eac
options in this dialog.

ENCODING OPTIONS

The following options are available when setting the attachment and text encoding values in you
QuickMail Pro preferences. 

TEXT ENCODING

QuickMail —Preserves the QuickMail message form and formatted message text when s
ing mail to another QuickMail user.

MIME (Stylized Text) —Sends MIME-compliant messages that can be read by any MIME
compliant E-mail package. The QuickMail Pro form is not saved, but the format preserves
ized text.

MIME (Plain Text) —Sends MIME-compliant messages that can be read by any MIME-c
pliant E-mail package. The QuickMail Pro form and stylized text are not saved.

Plain Text—Sends only the message text, using the RFC822 standard. For example, sele
Plain Text option when posting to automated lists that only support 7-bit ASCII text. 

ATTACHMENT ENCODING

BinHex—The default encoding method when you select Macintosh in the Computer pop-up 
menu. BinHex converts binary files to ASCII text files. Both the resource fork and the data
of the Macintosh file are transmitted. BinHex works best when recipients have a Macinto

uuencode—The default encoding method when you select UNIX in the Computer pop-up menu. 
uuencode encodes binary data as ASCII text files. uuencode works best when recipientsnot 
have MIME-compliant E-mail or a Macintosh.

Base 64—A robust encoding method designed to preserve an E-mail message as it pass
through E-mail gateways.

AppleDouble—The selected encoding method when Compatible or Windows is chosen in the 
Computer pop-up menu. Separates the data fork from the Macintosh-specific resource fork
using AppleDouble encoding.

AppleSingle—Transmits both the resource and data fork. Enclosures encoded with Apple
gle® must be read by MIME-compliant E-mail software or combined with uuencode.
26 Chapter 2



   

Table 1:   Selecting message encoding options

Recipient’s 
E-mail software

Computer field 
setting

Message 
Format

Enclosure 
Encoding

Unknown Compatible MIME (Plain Text) AppleDouble

QuickMail QuickMail QuickMail Binhex

Mac OS-based Mac OS MIME (Stylized Text) Binhex

Windows-based Windows MIME (Stylized Text) AppleDouble

UNIX-based UNIX Text uuencode

Mailing lists/ Usenet newsgroups used 
primarily by Macintosh users

Custom Text BinHex

Mailing lists/Usenet newsgroups used 
primarily by non-Macintosh users

UNIX Text uuencode
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WORKING WITH ADDRESS BOOKS IN THE CONTACTS MANAGER

The Address Book window appears when you click the Contacts button in the Message Browser window.
From this window, you have access to all of the individual contact information you have stored, a
ing you to choose one or more recipients to receive a message. You can also edit the contents of
ual entries by double-clicking an entry or highlighting an entry and pressing Return. 

Note: If the last access to Contacts Manager involved a link with a directory server, the directory s
window is displayed. Refer to “Directory Services” on page 50 for more information.

Figure 22: Sorting contacts

Entries are listed alphabetically according to the current Sort By selection: by Last Name, First Name, o
Organization. Clicking the alphabetic tabs at the top of the list displays the names starting with th
selected letter.

You can use the display filter options, specified on the line beginning with Show (right below the button 
bar, to selectively choose which information appears in the address book display. For example, y
could specify a filter to Show person beginning with “Mike.” If you then select the Sort By option to list names 
by First Name, the address book display will only show names beginning with Mike. The filters al
you filter by any item, local groups, server groups, organizations, departments, and mailing lists. U
ters to identify exactly the information that you want display, speeding up searches and making y
more efficient when locating data.

You can select a different Address Book (if you have created others) from the list that appears wh
click the Address Books button in the upper left portion of the window. The “Main” Address Book is c
ated automatically when you install QuickMail Pro, but initially it contains no entries. To add cont
to the Main Address Book, follow the procedure on “Editing Users in Address Books” on page 44
28 Chapter 2
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Messages are sent to each recipient listed in the TO, CC (carbon copy), and BCC (blind carbon copy) fields. 
Names in the TO and CC fields will be visible to all recipients. Names in the BCC field cannot be viewed 
by any persons who receive the message.

This window can also display a list of names and addresses from a query to a selected directory
You can generate a query to the specified directory server by entering the terms or names that y
to locate using the Show filter. QuickMail Pro returns a list of matching values and displays the result
the pane below the filter.

CONTACTS MANAGER BUTTONS

The buttons along the upper edge of the window offer additional features:

Choose Address Books—Lets you select from a list of available address books. 

Choose Directory Servers—Lets you select an available directory server to locate contacts throug
queries. 

New Contact—Opens a dialog for adding new contact information. You can select an address bo
which to store the new entry.

Delete Selected Contacts—Deletes the selected entry or entries that are currently highlighted in th
Address Book. 

ADDRESS BOOK FIELD SELECTIONS

The row of icons along the bottom of the Address Book window represent fields in the contact da
can be selectively displayed or hidden. Click an icon for each field that you want included in the w
dow. The following field selections are available:

■ Name Fields

■ E-mail Fields

■ Business Fields

■ Phone Fields

■ Location Fields

■ URL Fields

■ Member Fields

Each of the icons can be quickly identified by moving the cursor over it and waiting for the Hot He
appear with a description. You can select multiple items for display, but choosing too many items
make it difficult to view the full range of data in the Contacts Manager window.
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ADDING NEW CONTACTS

1 Click the New Contact button to display the New Contact dialog.

Figure 23: New Contact dialog

2 Enter the first and last name of the recipient in the First and Last text fields. You can also optionally 
enter a middle Initial. The combined length of the first and last names (and middle initial) is limi
to 255 characters. 

3 Enter the E-mail address of the recipient in the E-mail field. For example: susan@isp.com.

4 Optionally, you can enter individual personal information about contacts, such as their title, o
zation and department. You can also identify the contact’s Gender and add a Date of Birth to further 
personalize the contact data.

5 Select the E-mail tab and enter any additional E-mail addresses for the contact. You can highlig
one of these addresses and designate it the preferred address by clicking the Preferred button. 

6 Select the Mailer Encoding setting to use for enclosures from the drop-down list. If you have recei
mail from this contact, QuickMail Pro will display the Last Known Mailer to guide your selection. If 
you don’t know the appropriate encoding to use, select the Compatible option and QuickMai
will attempt to determine the encoding based on incoming messages from the contact. For m
details, refer to “Encoding Options” on page 26.

7 The Phone, Location, and Notes tabs let you record more information about each contact, includin
contact phone numbers, mailing addresses, and additional notes for your reference.

8 Once you have completed adding information for the contact, close the New Contact dialog. Quick-
Mail Pro displays the Save As dialog. 
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Figure 24: Saving contact data

9 If you have multiple address books, you can select the one in which to store the new entry. C
Save to store the new contact data in the selected address book. 

DRAGGING NAMES TO THE MESSAGE WINDOW

To select contacts for a message, drag names from the Contacts Manager (either the current Ad
Book or Directory Server) list to the address pane of the Message window. Names from multiple 
Address Books can be placed in the address pane. 

MAIL SETTINGS

Each of the different E-mail platforms is generally associated with a particular method of encodin
is applied to files that are attached to messages as enclosures. Many of the modern E-mail appli
can handle several different encoding methods, but if you don’t know which platform the recipien
using, QuickMail Pro also offers a Compatible option.

1 The Email tab for each person’s contact data contains a Mailer Encoding selection offering the follow-
ing choices: Compatible, QuickMail, MacOS, Windows, UNIX, as shown in Figure 25.

Figure 25: Mailer encoding options
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The type of encoding to use for each of these mail platforms is determined by settings that appea
you click the Advanced Preferences panel and select the Mailer Encoding option. QuickMail Pro is initially 
configured for the widest compatibility, but you can add or modify encoding option for various ma
platforms. Refer to “Setting Mailer Encoding Preferences” on page 24 for more details. 

SENDING ATTACHMENTS

Text messages can also include attached files, such as voice recordings, QuickTime movies, Acr
files, or graphics files. Use the attachments feature of QuickMail Pro to include any type of file al
with a message that is sent to a recipient.

If your Macintosh computer is equipped with sound capabilities and a microphone, you can also 
a spoken message and attach it as part of an E-mail message. You can include up to 16 separat
ments with a single message. The size limit that is acceptable for attachments is determined by 
individual POP3 server.

❖ Note: Be aware that if you attempt to send very large attachments to a recipient on another s
you may exceed the message handling capacity of that server. Check with your contact to se
there is a size limitation before sending large attachments.

SELECTING AN ATTACHMENT FILE

1 Create a message and click the Add or Save Attachments icon to the left and below the message 
address pane) to display the attachment options, as shown in Figure 26.

Figure 26: Attachment options

2 Click the Add Attachment option to access the Open File dialog.
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Figure 27: Open File dialog

3 Navigate through your folders until you locate a file that you want to attach. The Show Preview but-
ton lets you examine the contents of most graphics, sound, and multimedia files. Click Open once 
you have made your selection. QuickMail Pro returns to the Message window and shows the
attachment on the message form.

 
Figure 28: Attachment on the message form

4 Repeat this process if you want to add additional files. Each new attachment will be added to
attachments list. 

5 Click the Send button when you’re ready to transmit the message. The attachments will be enc
according to the information specified for your Mailer Encoding preferences. If you have type
the recipient’s address and that recipient is not stored in an Address Book, QuickMail Pro us
current default values to encode the attachments. 

❖ Note: You can also use drag and drop to add attachments to a message. Drag any file that yo
to add as an attachment into the attachment area in the Message window. QuickMail Pro dis
the file type of the attachment and encodes it as the message is sent. 
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ADDING VOICE ATTACHMENTS

Sometimes the tone of voice or the inflection of the spoken word can carry more meaning than w
words. If your Macintosh includes sound capabilities and you have a microphone, you can record
sages and enclose them within your electronic mail. 

To record a voice mail message:

1 Click the New button in the Message Browser.

2 Click the Add and Save Attachments icon and select Record Sound from that list that appears. The Mac
Sound Recording dialog appears.

Figure 29: Recording sound

3 Speak to test your microphone. If you see sound waves next to the speaker icon, your micro
input level is set correctly.

4 Click Record and speak into your microphone. The amount of time available to record is show
under the right end of the minutes bar. If you need to pause during your message, click Pause. If you 
finish with time to spare, click Stop.

5 Click Play to hear your message.

6 Click Save to add the voice attachment to the QuickMail Pro message. The attachment is show
speaker icon in the list of attachments. You can use the Play Sound option available through the Add 
and Save Attachments icon to sample the voice message again before sending.

Figure 30: Sound attachments
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▲ WARNING : Only QuickMail users can hear enclosed voice attachments.

ADDRESS BOOKS

Address Books enable you to quickly access information stored in the Contacts Manager, organi
and sorting contact data in a convenient way. The tabbed dividers that organize the data about e
son in an address book can include not only E-mail addresses, but phone numbers, physical add
organizational affiliations and titles, notes, and other details. A QuickMail Pro Address Book work
a convenient electronic contact manager, putting important contact information at your fingertips.

Each Address Book can store an unlimited number of names, but, practically speaking, you shou
exceed 5,000 names within a book. If you do, you will begin to see performance problems when 
ing or accessing data. You can also create large numbers of address books, but the practical lim
approximately 250. Within each Address Book, you can define lists of contacts organized by dep
ment, organization, or mailing lists. This gives you several different options for handling E-mail di
butions, allowing you to reach very specific groups or individuals with your messages.

CREATING A LOCAL ADDRESS BOOK

A local Address Book is stored on your computer. Use local Address Books to organize your pers
contacts.

1 Select Address Books in the Configure menu. The Address Books dialog appears.

Figure 31: Creating a local address book

2 Click the Add Local button. The Add Local Address Book dialog appears.
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Figure 32: Add Local Address Book dialog

3 Enter a name for the Address Book.

4 If you want this Address Book to be scanned for matches when you are manually entering a
address, select the Use for Tab Completion checkbox. This feature enables you to complete a partia
completed address entry when an Address Book match is found simply by clicking Return or
Tab key. QuickMail Pro either displays <Multiple matches found> as you are typing, or if the 
match is indisputable, the program displays the contact address. You can press Return any t
<Multiple matches found> is displayed to view a list of matching contacts.

5  Click OK when done to create your new Address Book. 

6 Add contacts to your new Address Book, as described on “Editing Users in Address Books” o
page 44. Close the Address Book when done. 

7 You can return to the Address Book dialog and rename any Address Book listed by using the Edit 
button.

CREATING A REMOTE ADDRESS BOOK

A remote Address Book is stored on the computer running QuickMail Pro Server. Use remote Ad
Books to search for all user addresses in your local domain. You can search for remote Address 
or manually add them.

SEARCHING FOR REMOTE ADDRESS BOOKS

1 Select Address Books in the Configure menu. The Address Books dialog appears.
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Figure 33: Creating a remote address book

2 Click the Add Remote button. The Add Remote Address Book dialog appears.

Figure 34: Add Remote Address Book dialog

3 Click Find remote address books on directory server in the Add Remote Address Book dialog and click OK. 
The Find Remote Master Address Books dialog appears.
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Figure 35: Find Remote Master Address Books dialog

4 Select a directory server from the Directory Server pop-up menu and click Find. The status line shows 
the progress of the search.

5 If the search locates a master address book, it is displayed in the Found address books area of the dia-
log. To add the master address book to your list of available address books, click the Add button. 
The master address book is then moved to the Added address books area of the dialog.

6 Click OK in the Find Remote Master Address Books dialog when you are finished. The Address Book dia-
log appears with the newly added remote Address Book listed amongst your local Address B

7 Click OK in the Address Books dialog when you are done making changes to your list of Address
Books.

MANUALLY ADDING REMOTE ADDRESS BOOKS

❖ Because knowledge of ldap syntax is necessary to manually add a master Address Book, CE
Software recommends only advanced users use this method to create a master Address Boo

1 Select Address Books in the Configure menu. The Address Books dialog appears.
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Figure 36: Creating a remote address book

2 Click the Add Remote button. The Add Remote Address Book dialog appears.

Figure 37: Add Remote Address Book dialog

3 Click Add manually in the Add Remote Address Book dialog and click OK. The Remote Master Address Book 
Properties dialog appears.
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Figure 38: Remote Master Address Book Properties dialog

4 Type a name for the Address Book in the Name field.

5 Type the address of your LDAP server in the Host field.

6 Type the syntax necessary for LDAP queries in the Fetch filter field. 

❖ The Fetch filter field should only be completed by advanced users who are familiar with the LDA
syntax.

7 Select an authentication option and click OK. The Address Books dialog appears.

8 Click OK in the Address Books dialog when you are done making changes to your list of Address
Books.

CREATING A LOCAL GROUP

If you routinely send messages to the same group of people, creating an Address Group lets you
messages and attachments to everyone included in the group. Other lists of contacts can be cre
represent organizations or departments, enabling you to send information targeted to a particula
of contacts. The contact information associated with a Local Group is stored on the client compu
no connection with the server is needed to access data about group members.

As shown on the File menu when selecting New, the icon next to a Group has two faces.

1 Select New from the File menu and choose Local Group. The Local Group dialog appears.
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Figure 39: Group dialog

2 Enter a name for the Group. You can also enter any other information about the Group on the
tab. 

3 Click the Members icon to access the current Address Book in Contacts Manager. The list of gr
members, which is initially empty, is filled out by making selections from the Address Book. T
easiest way to populate the membership list is to drag names from the Address Book to the 
bers field.

Figure 40: List of group members

4 After you add members to the new Group, close the dialog. QuickMail Pro prompts you to ch
an Address Book for storing the new group. 
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Figure 41: Choosing an address book

5 Select one of the displayed Address Books and click Save. The Group you have created will be 
shown in the designated Address Book the next time you open it. You can then select the Gr
a target for mail distribution.
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CREATING AN ORGANIZATION

If you need to add various institutions or organizations to your contact data, one way of doing this
creating an organization listing. An organization is a way of designating a category in the QuickM
Pro database for grouping individuals. For example, each person’s contact data in an Address B
includes a field for Organization. You can use an organization as a grouping tool to include memb
a mailing list or bulk mailing. The name of the organization and an individual’s affiliation with it as
shown in the Address Book becomes the method of directing the communication.

To create an organization:

1 Select New and then Organization from the File menu. The Organization dialog appears.

Figure 42: Organization data

2 Fill in the basic contact information in the Organization tab. 

3 Enter any additional details in the Phone, Location, and Notes tabs.

4 Close the dialog when done. The Save As dialog lets you choose the Address Book in which the 
organization you created will appear. You can sort the Address Book data by Organization usi
Sort By icon, providing an easy way to view all of the organizations that have been created with
Address Book.
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EDITING ADDRESS BOOKS

1 Select Address Books in the Configure menu to display a list of the currently defined Address Book

2 Select the name of the Address Book to edit.

■ Remove—Deletes the selected Address Book. You are asked to confirm deletion.

■ Add Divider— Inserts a line below the currently selected Address Book to help organize y
address book collection.

■ Properties—Lets you define a new name for the Address Book and determine whether thUse 
for Tab Completion feature is enabled. 

3 Click OK when done. 

EDITING USERS IN ADDRESS BOOKS

1 Select the Contacts Manager option from the Window menu. The contents of the current address bo
appear. If a Directory Server was last selected or to choose a different address book, click th
Address Books button and make your selection from the list of available address books.

2 Choose a view for displaying the contacts. For example, you might choose Persons from the Show 
menu is selected and then click the E-mail fields icon at the bottom of the window. 

Figure 43: Choosing a contacts view

3 Double-click the name of the contact that you want to edit. The Person dialog appears.
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Figure 44:  Editing fields for a person

4 Make any necessary changes to the entries on the individual tabs. Close the dialog when do

5 QuickMail Pro prompts you to save the changed data. Click Save to store the new information or 
Don’t Save to return to the previous contact data.

SUBSCRIBING TO A MAILING LIST

Subscribing to a mailing list enables you to receive E-mail on a wide variety of topics. Many comp
and organizations regularly use E-mail lists to provide new product announcements, offer technic
information to customers, inform product users of recent events, or entertain an extended audien
around the world. QuickMail Pro Server includes a list server function that allows it to be used to
out E-mail to an extended mailing list. The QuickMail Pro client includes features that make it ea
subscribe to a number of mailing lists.

To subscribe to a mailing list:

1 Select New and then Mailing List from the File menu. The Mailing List dialog appears.

Figure 45: Subscribing to a mailing list

2 Enter the identifying information that you need for the mailing list.
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3 On the URL tab, enter the address that is used to subscribe to the mailing list in the field lab
Subscribe URL. You can also enter additional contact information and URLs that apply to this m
ing list.

4 Return to the Mailing List tab and click the Subscribe button. QuickMail Pro completes the connectio
to the Internet and initiates the subscription.

5 Close the dialog when done. Choose an Address Book from the dialog that appears for stori
mailing list details.

❖ Note: To discontinue your subscription to the mailing list, select it from the Address Book and 
it for editing. Use the Show mailing lists icon to quickly scan through the available mailing lists. 
Select the Unsubscribe button to initiate the process for canceling the mailing list subscription.

IMPORTING ADDRESSES

If contact data was originally created in a text-based application, you can use the Import address
ture to bring this data into QuickMail Pro.

1 From the File menu, select Import and then choose Contacts as text file. The Choose a File dialog appears.

2 Locate the folder containing the file that you want to import. You can use the Show Preview button to 
view the contents of any selected file.

3 When you have located the appropriate file, click Choose. The contact information must be a tab-
delimited text file. For example, Smith <tab> Joe <tab> Joe.Smith@cesoft.com <tab> QuickMail <tab> Quick-
Mail <tab> Binhex. QuickMail Pro displays the Contacts Import Order dialog that lets you determine the
sort order of the incoming records so that you can match the data to the fields in an Address
46 Chapter 2



 data 
ook, 
ntry 
der 

ss book 

n 
e 

ed by 
Figure 46: Contacts Import Order dialog

4 Click and drag the Available Fields titles on the right side of this dialog to match them with the
shown on the left side. If there is incoming data that you don’t want to include in the Address B
click the center column beside that item so that the arrow turns to a dashed line. Each data e
with an arrow beside it will be imported to the field shown directly to the right. Edit the sort or
until you have each data entry matched to its corresponding field and then click Import.

5 Select an Address Book as a target for the import operation. You can also create a new addre
to store the incoming data and click OK.

6 To verify the imported data, select the Choose Address Book button in the Contacts Manager and ope
the address book that contains the new data. You can scan the collection of data or look at th
details by double-clicking an individual entry.

During the import process, QuickMail Pro verifies the record components. 

■ Records with the incorrect number of fields are skipped. 

■ Truncated records are invalid. 

■ Any address that has a text-size violation is skipped. 

■ If a format error is detected, the appropriate error name, incorrect field information and 
offending row number are displayed. You can cancel the import at this time.

All non-text files are filtered from the list of available import files. Current addresses are not affect
the import process. Only new, non-duplicate addresses are imported. 
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❖ Note: Each QuickMail Pro Address Book can hold an unlimited number of individual addresse
We recommend that you do not exceed 5,000 entries in a single address book. Create one o
additional address books if you find yourself approaching this number of entries. 

IMPORTING OTHER TYPES OF ADDRESS FILES

Besides text files, QuickMail Pro can import address data from other sources, including:

■ LDIF files: the file format recognized by LDAP clients; a number of applications can store 
in LDIF format

■ QM 1.X address books and groups: QuickMail Pro address book data from earlier releas

■ Outlook Express export files: Address data exported by Microsoft’s Outlook Express E-m
application

To import address data in one of these formats:

1 From the File menu, select Import and then choose the appropriate option: Contacts as LDIF file, QMP 
1.X Address Book, QMP 1.X Address Group, Outlook Express Export File. The Choose a File dialog appears.

2 Locate the folder containing the file that you want to import. You can use the Show Preview button to 
preview the contents of any selected file.

3 When you have located the appropriate file, click Choose. 

4 Select an Address Book for the import operation.

5 QuickMail Pro displays the progress as the file is being imported. When the operation is com
you can edit the address book contents as described in “Editing Users in Address Books” on
page 44.

EXPORTING ADDRESSES

You can export the contents of any of your Address Books maintained by Contacts Manager into
dard text files. Text files can then be used to transfer data to other types of applications, such as d
or spreadsheet applications.

To export contact data as a text file:

1 From the File menu, choose Export and then Contacts as Text File.

2 Make a selection from the Choose Address Book dialog that appears. Click OK to confirm your selec-
tion. The Contacts Export Order dialog appears.
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Figure 47: Contacts Export Order dialog

3 Select the data items from the Available fields column that you would like to include in the ex
operation. To add the whole list of data items, click the Add All button. If you want to remove an 
item from the Export order column, highlight it and click Remove.

4 Click and drag to adjust the order of the data items as they appear in the Export order colum
is the order in which each of the fields will appear in the text file that is created.

5 Click Export. A standard dialog prompts for a destination file. When you export the file nothing
ible happens; however, when you close the Editing dialog, the address file will be in the location tha
you specified.

❖ Note: If the filename that you have specified already exists, confirm replacement of the existin
to overwrite the earlier file. 

Once you have completed the export operation, the text file produced can be imported into other
grams that accept tab-delimited text. 

EXPORTING ADDRESSES TO LDIF FORMAT

1 From the File menu, choose Export and then Contacts as LDIF File.

2 Make a selection from the Choose Address Book dialog that appears. Click OK to confirm your sele
tion. 

3 Choose a destination folder and a file name for the export operation. By default, the .LDIF ex
sion is added to the file name. Click OK to start the export.
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4 A progress indicator displays while the export operation is taking place.

5 When the operation is complete, you can exchange the LDIF file that was created and the fil
tents can be imported into typical LDAP client applications.

DIRECTORY SERVICES

QuickMail Pro users can receive contact data updates through the QuickMail Pro Directory Syste
the necessary software is installed and configured on the QuickMail Pro Server. The QuickMail P
Directory System provides a highly automated means for distributing contact data throughout an 
zation, including data that is harvested from incoming E-mail messages that have been received
E-mail clients connected to the mail system.

LDAP SUPPORT

Lightweight Directory Access Protocol (LDAP) is an industry standard protocol used to query 
directories for information. LDAP directories are like “white pages” in a phone book, except they 
public directories that can be queried over the Internet. Some directories provide E-mail address
telephone numbers, fax numbers, and postal addresses. Through QuickMail Pro you can access
directories such as Four11, BigFoot, Internic, and USDSA.

CONFIGURING DIRECTORY SERVERS

1 Select Directory Servers in the Configure menu. The Directory Servers dialog appears. A list of currently 
configured directory servers appears in the dialog.

Figure 48: Directory Servers dialog

2 To configure an additional directory server, click the Add button. The Add Directory Server dialog 
appears.
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Figure 49: Add Directory Server dialog

3 Enter the Name and LDAP settings for the server. The Host field specifies the LDAP domain name fo
the server providing the directory services, such as ldap.bigfoot.com.

4 The Default Port for LDAP access is 389, but you can override this default value by checking
Override Default Port option and entering a different port value.

5 Enter any search limitations, such as the Max Hits retrieved during queries and the Timeout value in 
seconds (after which the search will terminate). You can also specify a Search Root as a starting point 
for directory server search operations.

6 Choose an authentication option from the three available selections.

7 Click OK to save your changes and return to the previous display.

EDITING DIRECTORY SERVER ENTRIES

You can make changes to any of the entries for the listed directory servers by highlighting the se
name in the Directory Server dialog and clicking Edit. The Edit Directory Server dialog appears.
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Figure 50: Edit Directory Server dialog

1 Complete the Edit Directory Server dialog to add or edit private or public LDAP directories.

Name—The unique name for the directory.

Host—An IP address or a DNS entry to access the directory server.

Override Default Port—Most LDAP directories use port number 389. To override this valu
select the checkbox and enter a new value in the field.

Max Hits—Determines the maximum number of responses that will be retrieved from a d
tory server query. The default value is 100.

Timeout (sec)—Indicates the maximum time in seconds that a server is allowed to comple
query before the request is terminated. 

Search path—Tells the search where to begin in the directory structure (person, organiza
or country). An entry in this field may not be required because many servers store direct
data in the same area and searches begin at the same place. An example of a Search Path is c=GB, 
which means “country equals Great Britain”.

Authentication options—Determines if authentication applies to the query. If you choose 
Don’t Authenticate, no password or account name are transferred. You can also choose to au
ticate using your mail account login values or another Account and Password that you specify in 
the fields provided.

2 Click OK in the Edit Directory Server dialog to complete the changes and return to the previous dia
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USING LDAP

You can perform simple or complex searches with LDAP.

BASIC SEARCH

1 Click the Contacts button in the Message Browser window. Contacts Manager opens the curren
address book or the most recent directory server.

2 Click the Directory Server icon. The directory query screen appears.

Figure 51: LDAP search options

3 Complete the search criteria using the drop down list box selections to determine the search
to be used. Click Find to initiate the search. The More and Fewer buttons let you add or subtract add
tional criteria from the search operation. The search results appear in the lower pane, displa
those fields for which you have selected corresponding icons at the bottom of the window. Th
order is determined by the Sort By selection (First Name, Last Name, or Organization).

❖ Note: One wildcard character (*) is supported in the Search for field.

4 Click and drag an address from the search results to the address pane of the Message wind
can also use the To:, Cc:, and Bcc: buttons to transfer highlighted addresses to the address field f
the message.

Your E-mail message is now addressed to the user(s) you selected.

■ The addresses retrieved during a directory services search can be saved in any address
group. 
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CHECKING YOUR SPELLING

QuickMail Pro includes a built-in spell checker that can check the spelling of terms in the body of
message and the subject line. 

To perform a spell check:

1 Open a message and click the Spell button. QuickMail Pro scans for misspelled words. When text
highlighted before you select Spelling, only the highlighted text is scanned for errors. When text 
not highlighted, QuickMail Pro scans all text for misspelled words. The spelling checker skip
URLs.

2 The spelling checker pauses and offers suggestions when it encounters an unknown or miss
word. 

Figure 52: Spelling dialog

Context—Displays the detected misspelled word in the sentence in which it appears. 
If possible, the Context field displays the sentence before and after the error.

Change to—Contains the correct spelling of the word. Select the correct word from the Sug-
gestions list or type words in this field.

Suggestions—Lists possible words to use in place of the misspelled word. Highlight a wor
place it in the Change to field.

Add Word—Adds the word displayed in the Change to field to the dictionary. 

Dictionaries—Lets you select an appropriate dictionary to use for the spell check.

Options—Opens the Dialects dialog so that you can choose among American, British - ise, and 
British - ize dialects. 
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3  Click Replace to substitute a suggested spelling for the term displayed. 

■ Replace All substitutes every duplicate error with the word displayed in the Change to field.

4 Click Ignore to bypass the flagged word and to continue the check.

■ Select Ignore All if you are positive that every occurrence of a flagged word is correct. The 
Spelling Checker then temporarily bypasses all occurrences of that particular word.

5 Close the dialog to return to the Message Window. Any changed words or dictionary modifica
are saved. A dialog displays the number of words modified.

❖ Note: The Spelling Checker dialog displays only when spelling errors are detected.

SELECTING A DICTIONARY

Select Dictionary in the Spelling dialog to choose the appropriate dictionary to use for your spell check
Select one language; the language can be changed at any time. 

STANDARD DICTIONARY

Select the appropriate dictionary from the Dictionary drop-down list. You can change dictionaries durin
a spell check. This feature accommodates QuickMail Pro users who use several languages. Whe
ferent Dictionary is selected during a spell check, the check begins from the paused position: the st
the last misspelled word detected.

SELECTING DIALECTS

1 Click Options to display the Dialects dialog.

Figure 53: Dialects dialog

2 Select the checkbox that applies to your dialect.

3 Click OK to apply your selection.
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USING STYLIZED TEXT

The Format bar offers text formatting options, including:

■ Font selection from the fonts available on your system
■ Font style (bold, italic, underlined.)
■ Font sizes
■ Colors that can be applied to text

Stylized text is only available in the message body; subject lines cannot use stylized text. You can
text prior to typing, or you can highlight text to change it. 

Figure 54: Stylized text

➣ IMPORTANT : Stylized text and HTML formatting are only preserved when the recipient’s E-mail
software supports it. 

FONT
Set the font in your message to any font available on your system. When you receive a message
font not available on your machine, QuickMail Pro substitutes the default font specified in the Dis
panel of the preferences.

STYLE
Set the style of the text in your message body. All fonts can use these styles. When font substitu
occurs, QuickMail Pro retains the style settings with the substituted font. Text styles are Plain, Bo
Italic, and Underline.

Format bar
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SIZE
Set the point size of text that appears in the message. The individual sizes available depend upo
font. 

COLOR
Colors can be applied to any font, style, or size. 

DEFAULT DISPLAY SETTINGS

You can select the options to use for fonts throughout QuickMail Pro through the Display settings in the 
Preferences panels. Refer to “Display” on page 82 for information on how to modify your settings.
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CHAPTER 3: RECEIVING MAIL

QuickMail Pro is more than just a basic E-mail application—the product design includes many diff
ways to filter and organize your incoming mail to make you more efficient in both your business a
personal correspondence. This chapter covers reading messages, retrieving attachments, mail n
tion, and organizing new mail.

THE MESSAGE WINDOW

Figure 55 shows the organization of the Message window used for reading messages. Some of t
options provided on the menu bar and button bar are different from those offered in the Message
Browser. For example, the Send button is replaced by the Forward and Reply buttons.

Figure 55: The Message Window

Button bar

Move forward and 
backward through 
the Inbox

Subject line

Message body

Message priority

Message number

Attachments list
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MANAGING INBOX MAIL

The Inbox serves as the first stop for all mail that you receive. Once a message has arrived in yo
Inbox, you can handle it in a number of ways; messages can be read, forwarded, answered, prin
deleted, saved, and filed. The way in which the messages are displayed by QuickMail Pro can al
managed by setting up rules and adjusting the Preferences for the program.

RETRIEVING MAIL

Depending on your preferences, new mail can be retrieved automatically, on a schedule that you
or manually, whenever you want to check to see if new mail has been delivered to your account o
server. If your mail host is QuickMail Pro Server, you can also receive notification that mail has ar
you can then retrieve it at your convenience. By default, QuickMail Pro checks the server for new
every 15 minutes. To change the schedule by which mail is retrieved, refer to the instructions in “
ing and Receiving” on page 86.

To manually check for new mail, open Send and Receive from the File menu and choose Check All Accounts. 
QuickMail Pro proceeds to check each defined E-mail account in sequence and announces if yo
received new mail. For one-click access to your incoming E-mail, you can use the Check Mail button on 
the button bar.

In the Connection Status portion of the Message Browser window, you can watch the progress as Qu
Mail Pro connects, checks for mail, and disconnects from the POP3 server. See Figure 12 on pag
an illustration of the Connection Status line.

NOTIFICATION

QuickMail Pro notifies you immediately whenever new mail arrives in the Inbox. Depending on ho
your preferences are set, QuickMail Pro sounds a chime to indicate that new mail has been recei
repeats this chime every 15 minutes until you access the Inbox. You can also set your preferenc
that notification is by means of a flashing icon that appears beside the Apple icon in the upper le
ner of your display or by speech notification.

If you would rather not receive notification for new messages or you want to change the frequenc
notifications, you can change the settings, as described in “Sending and Receiving” on page 86.
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READING MESSAGES

The Inbox stores all incoming messages until you either file or delete them. Messages can be vie
the following ways:

■ Select the Message Peek option in the lower left corner of the Message window. This pro
a preview of each highlighted message in the Message Peek pane. Refer to the next sec
more information about Message Peek.

■ Select a message and press c-O. 

■ Double-click the message. 

■ Select the message line and press Return.

■ Select the message line and click the Read button.

■ Select the message line and choose Open Selection in the File menu.

■ Press c-(right arrow key) to open the next message listed in your Inbox.

■ Press c-(left arrow key) to open the previous message listed in your Inbox.

MESSAGE PEEK

The Message Peek feature lets you view a selected message while you are in the Message Browser. 
can quickly determine the general content of messages, without having to fully open the messag
Message Peek can be used on messages stored in any of your mail folders, the Inbox, the Outb
even messages in the Trash.

To use this feature, click the Message Peek option in the lower left corner of the browser window
contents of each highlighted message then appears in a pane at the bottom of the browser wind
shown in Figure 56. Close Message Peek by clicking the icon a second time.
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Figure 56: Message Peek

FORWARDING MESSAGES

You can resend any messages that you have received to other parties by using the forwarding fe
QuickMail Pro.

❖ Note: The QuickMail Pro panel in the Preferences window includes Behavior options that can 
automatically control the default action when you choose to forward a message. You can set
configuration to Forward with changes, Forward as is, Redirect, or Ask me. The Ask me option, if selected, 
displays a dialog each time you choose to forward a message, letting you select the appropr
forwarding option at that time.

To forward a message:

1 Open a message that you received and choose Forward from the Message menu, or click the Forward 
button. If the Ask Me option is active in the Behavior panel of the Preferences dialog, the progr
displays your forwarding options.

Figure 57: Mail Forward options
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2 Choose the option that applies to the message that you want to forward. With Changes includes any 
markups or edits that you have made to the content of the message. As Is sends the message withou
modifications. Redirect keeps the message originator when the message is sent, so the recipie
your forwarded messages sees the original sender rather than the forwarding sender.

3 If you have elected to “forward with changes,” you can type any comments or notes into the 
sage body, if you want to include additional material for the recipient.

4 Click the Contacts button and select one or more recipients from the Address Book or Directory
Server window that appears. Each selected recipient will receive the forwarded message.

5 Click Send to route the message to the indicated recipients.

❖ You can also select a message in your Inbox and press the Control button to display a conte
menu. Select Forward from the contextual menu to forward the message to another user.

REPLYING TO MESSAGES

To reply to a message:

1 Click the Reply button in an open message. The Reply To dialog appears if the message inclu
more than one possible recipient.

Figure 58: Reply To options

2 Select one of the Reply To options and click OK. 

■ Select Reply To: Sender to send the reply to the person who forwarded the message to you. 

■ Select Reply To: Originator to direct your reply to the source of the original message.

■ Select Reply To: All to send the reply to anyone listed in the To and Cc fields. 

3 The Reply form displays the original message with a flashing cursor to mark the point where
reply will be added. The original text is marked by whatever symbol you selected in the Mess
Panel Reading options in Preferences. If your reply is being sent to another QuickMail Pro u
you can select one of the forms from the Format bar to apply to the message.

❖ You can also select a message in your Inbox and press the Control button to display a conte
menu. Select Reply from the contextual menu to reply to the sender of the message.
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Figure 59: Reply with quoted text

4 Type your reply and click Send.

When the reply arrives, it is listed with RE: by the subject of the message in the Subject column of the 
Message Browser. Your Sending Preferences determine if the body of the original message is on th
Reply form. See “Sending and Receiving” on page 86 for instructions on how to set up this featu

❖ Note: The QuickMail Pro panel in the Preferences window includes Behavior options that can 
automatically control the default action when you choose to reply a message. You can set th
configuration to Reply to sender, Reply to originator, Reply to all, or Ask me. The Ask me option, if selected, 
displays a the dialog shown in Figure 58 each time you choose to reply to a message, letting
select the appropriate option at that time.

SAVING THE SENDER’S ADDRESS

Each message you receive has a “From” list, which displays who has sent, forwarded, or replied
message you have received. You can copy the sender’s address by double-clicking the Person icon that 
appears to the right of the From label. The contact information for the selected sender appears in
Persons dialog, as shown in Figure 60. Add or change any data that appears in the dialog, as nece
Close the dialog and then respond to the request from the program to select an address book in w
save the entry.
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Figure 60: Person dialog

DRAGGING THE SENDER’S ADDRESS
To drag the address from a received message to your Contacts Manager:

1 Open a message from any of the folders in your Message Browser.

2 Open the Contacts Manager and select the Address Book in which you want to save the sen
address.

3 Click on the person icon beside the sender’s address and drag the person icon to the listings
the Address Book. QuickMail Pro transfers the address to the designated Address Book.

4 Close the Address Book and confirm the changes by clicking the Save button.

PRINTING MESSAGES

To print a message, select the message in the currently open folder and use one of these metho

■ Click the Print button on the button bar

■ Select Print in the File menu, or 

■ Press c-P. 

Print displays the page setup and print dialogs. Set the appropriate options and click Print to complete the 
print operation.

❖ Note: Text that extends beyond the width of a column (for example, the Subject or Who columns) is 
replaced with an ellipsis.
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SHOWING INTERNET HEADERS

QuickMail Pro normally suppresses the contents of the Internet header, which consists of inform
describing the message addressing, contents, routing, and other details that are crucial to transp
message, but usually not particularly interesting to users. However, there are times when you ma
to refer to these details; when you do, you can access the Internet header by selecting Show Internet Head-
ers from the Message menu.

To view a message header:

1 Highlight a message in the Message Browser.

2 Select Show Internet Headers from the Message menu. The header contents appear in a separate w
dow, as shown in Figure 61.

Figure 61: Show Internet Header window

3 Click OK when done viewing the header.

❖ You can also select a message in your Inbox and press the Control button to display a conte
menu. Select Show Internet Headers from the contextual menu to display the Internet header for th
selected message.
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MOVING MESSAGES TO TRASH

There are several ways to move unwanted messages to the Trash:

■ Click the Delete button with a message open or highlighted. 

■ Press c-D in an open message.

■ Select multiple message(s) in the Inbox, Outbox, Sent Items, or other folders. Then selecClear 
in the Edit menu.

■ Select a message in your Inbox and press the Control button to display a contextual men
Select Move to Trash from the contextual menu to move the selected message to the Trash.

■ Drag the message to the Trash. You can select multiple messages using standard Macin
methods, such as holding down the Shift key while selecting a range of messages, and t
drag them all to the Trash at the same time.

❖ If you attempt to delete an unread message, an alert appears. Press c-(backspace) or c-delete to 
bypass the alert.

Items remain in the Trash until you select Empty Trash from the Tools menu, or until one of the events 
described in the following section, Emptying Trash, takes place.

EMPTYING TRASH

You can empty your Trash and permanently delete mail in the following ways:

■ Select the System panel in the QuickMail Pro preferences and check the option Empty trash on 
quit. Each time you exit QuickMail Pro, messages marked for deletion are removed. For m
details on configuring this feature, see “System” on page 80.   

■ Select Empty Trash from the Tools menu or press c-T.

■ Click the Trash folder in the Message Browser and press the Control key to display a cont
menu. Select Empty Trash from the contextual menu that appears.

SAVING MESSAGES AS TEXT

QuickMail Pro can convert a message into a text file that can be read by most word processors. 

To create a text file:

1 Open a message. 

2 Select Save as in the File menu. The standard Save As dialog appears.
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Figure 62: Saving a message as text

3 Ensure that the File Format is set to Text Document.

4 Make any necessary changes to the name for the file and specify a destination for it.

5 Click Save. 

The converted message file can be found in the indicated folder and opened with a text editor or
processor.

FILING MESSAGES

To stay organized, file or delete any messages you do not need to keep in your Inbox. When you 
a message you need for future reference, file it in a personal folder. To see a list of messages in 
folder, double-click the folder to open it or click the arrow beside the folder to expand the folder c
tents. Click the close box to close it or click the arrow again to collapse the folder contents. 

To file a message:

1 Select a message to file in the Message Browser. Click the File button to display the File Message dia-
log.

Figure 63: File Message dialog
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❖ Note: A folder named My Filed Mail is automatically created in the Personal Folders directory when 
QuickMail Pro is installed. To create other folders, see “Creating a Mail Folder” on page 73.

2 Select a folder and click File. My Filed Mail may be your only option if you haven’t created any oth
folders.

3 A filing status bar appears briefly and your message is filed in the folder you selected.

❖ You can also select a message in your Inbox and press the Control button to display a conte
menu. Select File into Folder from the contextual menu to display the File Message window. Choose 
the folder in which you want to file the selected message and click the File button.

NESTING FOLDERS

You can nest one mail folder within another by dragging and dropping the folders over each other
Message Browser. Nesting folders enables you to organize your mail folders much like you organ
folders in the Finder.

STREAMLINED MESSAGE HANDLING

From the Message Browser window, you can quickly manage messages by dragging the listed m
to an appropriate button on the QuickMail Pro button bar. When you drop the message, QuickMa
performs the selected operation. For example, to quickly file a message, highlight its name in the
Message Browser list and then drag the message icon to the File button on the button bar. QuickMail Pro
brings up the File Message dialog so that you can quickly assign a folder for storing the messag

Figure 64: Buttons that support drag and drop

MARKING MESSAGES

There are several options in the Message menu that let you mark messages. You can use these option
group and categorize a range of message; for example, you can flag several messages to forwa
single recipient. Or, you can mark a group of messages to be deleted according to the preferenc
have been set (such as permanently deleting the messages from the Trash when QuickMail Pro 

To use markers on messages:

1 Select one or more messages in the Message Browser.

2 Open the Message menu and choose the appropriate marker from the options shown in Figu
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Figure 65: Message markers

3  You can reverse any marker assignments by returning to this menu and selecting the oppos
choice. For example, if you have selected Mark as Read for a message, use the Mark as Unread option 
to remove the flag.

❖ You can also select a message in your Inbox and press the Control button to display a conte
menu. Select one of the Mark as or Unmark as options from the contextual menu to mark the selecte
message.

FLAGGING A MESSAGE

You can also mark messages using a flag, to easily locate specific messages for later reference o
a group of messages using the flag as a marker. To apply a flag to a message, select Mark as Flagged from 
the Message menu. To remove a flag from a message, highlight the message and select Unmark Flagged 
from the Message menu. Messages that have been marked in this way display a small flag in the m
beside the message.
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DELETING A GROUP OF MESSAGES

You can use markers to select a group of messages for deletion. 

To delete a group of messages:

1 Highlight the individual messages that you want to delete

2  Open the Message menu and select Mark as Deleted.

3 From the Tools menu, select Purge Deleted Messages. The messages marked for deletion will be per
manently removed from your computer.

RETRIEVING LARGE MESSAGES

When you open a message in your Inbox that displays a fragmented-message icon, the program
you that a message on the POP server is “X” kilobytes in size. The fragmented icon indicates tha
message is larger than what is specified in your Don’t download messages larger than “X” K preference. See 
“Sending and Receiving” on page 86 for information on modifying the maximum download size fo
message. 

You can retrieve an oversized message, if you determine that the message contains information t
want to retrieve. 

To retrieve a large message:

1 Highlight the message in the Message Browser list.

2  Select Retrieve Large Message from the Message menu.

QuickMail Pro retrieves the message at the next scheduled connection.

❖ You can also Control-click a message with a fragmented-message icon and select Retrieve Large 
Message from the contextual menu that appears.

▲ WARNING : When you delete a message that displays the fragmented message icon, the messa
any corresponding attachments are also deleted from the POP server.
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CONFIGURING SHARED MAILBOXES

Shared mailboxes are essentially electronic mailboxes that can be accessed by multiple users. F
ple, if your mail administrator has set up a “Public” mailbox for everyone in your company, that m
box can serve as a type of public bulletin board system. People can send a message to the “Pub
shared mailbox and everyone in the company will receive that message. A message posted to th
mailbox remains there until the server, the sender, or the administrator deletes the message or u
sender unsends the message.

To set up a shared mailbox:

1 Select Shared Mailboxes from the Configure menu. The Shared Mailboxes window appears.

Figure 66: Message markers

2 Click the Update List button. If your mail administrator has set up a shared mailbox, it appears in
Shared Mailboxes window with Not subscribed listed in the Subscription column.

3 Click the shared mailbox to which you want to subscribe and click the Subscribe button. The infor-
mation in the Subscription column changes to show that your are now subscribed to the selecte
mailbox. 

4 Click OK when you are finished. Next time you open the Message Browser, your shared mail
will display and you will be able to read any mail that is sent to that mailbox.
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MANAGING MAIL FOLDERS

Mail folders provide an easy way to organize messages you want to keep. QuickMail Pro offers th
ibility to let you create as many folders for archiving as you need under the Personal Folders dire
that is shown in the Message Browser.

On a shared computer, each person can only access the folders that are created under their acc
QuickMail Pro indexes filed messages using the account information of the logged-in person.

CREATING A MAIL FOLDER

1 Open the File menu and select New and then Personal Folder. The New Folder dialog appears.

Figure 67: New Folder dialog

2 Enter a name for the new folder in the name field.

3 Click the Folder icon if you want to assign a particular icon to correspond with the newly crea
folder. The Icon Picker dialog appears. You can select from the QuickMail Pro icon set or any ot
available icon sets. The chosen icon will appear in the Message Browser and other windows
resent the folder that you create.

Figure 68: Icon Picker dialog
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4 Highlight an icon to use for the folder and click OK. 

5 Click New to create the folder. The folder and its corresponding icon will appear in the Personal Fold-
ers area.

From the Message Browser, you can drag and drop messages from any displayed folder to any 
folder. This provides an easy way to organize and consolidate messages and to maintain an ong
archive of important messages. Use the arrow symbols at the far left column of the browser wind
expand and collapse folders to display or hide their contents. To move a message from one folde
another, highlight the message and drag it to a new location. 

For example, to quickly sort and process the contents of your Inbox, use Message Peek to previe
message contents while you move through the message list and transfer each message either to
sonal Folder or to the Trash. 

FINDING TEXT IN MESSAGES

Use the Find feature to locate text or text strings in a selected message.

1 Open a QuickMail Pro message. 

2 Select Find in the Edit menu or press c-F.

Figure 69: Find dialog

3 Enter text in the Find field. You can search for any text, word or group of words up to 255 charac
in length. 

4 Click Find to scan all fields within a message. 

■ Select Find Next in the Edit menu or press c-G to locate the next occurrence of the specified te
in the open message. Find Next starts at the end of the currently selected text.
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RECEIVING ATTACHMENTS

In QuickMail Pro, you can receive large files, graphics, or sound files as attachments. The attach
option allows you to receive multiple attachment files, limited only by available memory and disk 
age space.

INCOMING ATTACHMENTS

The program notifies you in two ways when you receive a message with an attachment: 

■ In your Inbox, the icon next to the message has a smaller icon next to it.

■ In an open message, an expandable list of attachments appears below the address.

RETRIEVING AN ATTACHMENT

To retrieve an attachment:

1 Open a message that contains an attachment.

Figure 70: Message with an attachment

2 Click the drop-down arrow next to the Attachment icon to display the file type and size of the attac
ment. 

3 Click the Attachments icon to display the available options for handling the attachment. A menu
choices appears.

Figure 71: Attachment options
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4 To save the attachment as an external file, select the Save Attachment option. QuickMail Pro saves the
file in the folder that you specify; it can then be launched in the appropriate application. If you
multiple attachments, QuickMail Pro gives you the option to Save All Attachments.

5 Close the message window when done.

LAUNCHING ATTACHMENTS

Most attachments can be automatically saved and launched by double-clicking the item. QuickMa
saves the files to a specified location and then launches the application in which the attachment 
ated. To launch an attachment:

1 Open the message and display the list of attachments. 

2 Double-click the attachment you want to launch. 

3 If you have the application in which the file was created, or an equivalent application, the program 
opens the selected attachment. If the program cannot determine the appropriate application
launch the attachment, it displays a list of possible applications and lets you choose the one
appropriate.

QuickMail Pro automatically stores the file attachment in a folder called Retrieved Attachments in
QuickMail Pro folder.

LISTENING TO VOICE MAIL ATTACHMENTS

Messages that have voice mail attachments can be recognized by a speaker icon shown in the a
ments list below the message address.

PLAYING VOICE MAIL

A Voice Attachment is a recording that can only be opened by QuickMail Pro. To listen to voice mail:

1 Open the message. If autoplay is selected in the Preferences, the voice mail will play as soon
open the message.

2 Highlight an attachment marked with the speaker icon in the list. Select Play Sound from the Attach-
ments options (accessed by clicking the Attachments icon beside the attachments list). You can also
double-click the audio file to start playback.

❖ Note: When the Play voice mail automatically option is checked in your Sending and Receiving Preferences, 
voice mail messages play back immediately. See “Sending and Receiving” on page 86 for m
information.

You can send audio files to mail users on other platforms as standard attachments. For example
want to send a voice message to a Windows user, you can save the recorded audio as a QuickT
If the Windows user has the QuickTime player installed, they can retrieve the audio attachment a
ten to it. The mail encoding options should be set to the Windows-compatible settings for this proc
work.
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LOGGING OUT OF QUICKMAIL PRO

Select Logout from the File menu to terminate your mail session on the Internet. Logout is useful when 
you want to reduce dial-up connection charges.

Select Quit from the File menu to close the QuickMail Pro application, but remain connected to the I
net or the local mail server. When you select Quit from the File menu, you continue to receive mail 
through QM Networker.
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CHAPTER 4: PREFERENCES

Preferences provide a way for you to configure QuickMail Pro so that it operates according to yo
needs. Within the Preferences window, there are panels that control E-mail account details, pers
data, signatures, message send and receive settings, and the appearance options for QuickMail 
chapter explains how to configure each option so that QuickMail Pro runs according to your prefe
ences.

PREFERENCES PANELS

To make changes to the preferences that QuickMail Pro uses each time you launch it, choose Preferences 
from the Configure menu. The Panels shown in the left side of the Preferences window provide acc
each of the options. You can expand or collapse the panel categories (QuickMail Pro, Identity, and so on) by 
clicking the arrow beside the category name. Select an individual panel by clicking on its name—
panel options appear directly to the right.

SAVING AND REVERTING PANEL SETTINGS 

Use the Save Panel button to save any changes you make to an individual panel. You can also return 
earlier values after you make changes by clicking the Revert Panel button. The Save button, to the right of 
the window, saves all of the changes made in panels since the window was accessed. Cancel exits with-
out storing any of the changes since the last save. Dots that appear to the left of Panel names in
changes have been made to panel settings that have not yet been saved.

Figure 72: Preferences panels
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The following sections describe each of the panel options, category by category.

QUICKMAIL PRO OPTIONS

Panels in the QuickMail Pro category include:

■ System

■ Display

■ Behavior

■ Forms

■ Send/Receive

SYSTEM

System Preferences determine how QuickMail Pro functions at the System level.

Figure 73: System preferences

Startup & Quit— Defines what tasks that QuickMail performs when your computer starts and quit
application. The first option, On computer startup, QuickMail will:, determines the login method. Select Ask 
me to login to ensure that security is maintained for your computer; this option requires that you pr
your password each time you start QuickMail Pro. Select Login for me to allow QuickMail Pro to auto-
matically fill in your password and start the application.
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Empty trash on quit—The Empty trash on quit checkbox, if selected, causes QuickMail Pro to delete 
messages present in the Trash folder each time you exit the program. 

Send all outgoing messages on quit—If selected, the Send all outgoing mail messages... checkbox causes 
the application to deliver all pending messages in the Outbox before exiting.

Activate Hotkeys—If selected, the QuickMail checkbox activates the hot-key combination displayed to
launch QuickMail Pro. To change the hot-key combination, highlight the current hot key and ente
new key combination. If selected, the QuickSend checkbox lets you send a quick message from within
any application, by pressing the indicated hot-key combination. You can also change the hot-key 
nation by typing a new entry in the corresponding box.

Notification—Determines how QuickMail Pro notifies you when certain types of mail have been 
received. A different kind of notification can be assigned to incoming New Mail, Priority Mail, and New 
Receipt. For a speech synthesized notice, select Speech Notification; QuickMail Pro will inform you what 
type of message or receipt has been received. You can also choose the Default Sound (a chime), any of the 
standard Macintosh alert sounds, or No Sound. You can repeat the audible notification by selecting the
Repeat every... checkbox and entering the interval you want QuickMail Pro to use. If selected, the Display 
icon in menu bar check box flashes a small QuickMail icon near the apple in the Apple menu to aler
to mail arrival. You can use both the audible and visual cues or turn off notification completely. 

When the QuickMail Pro logo is clicked, launch this URL—Specifies the URL to access when the
QuickMail Pro logo is clicked from within the application. By default, the URL links to CE Softwar
QuickMail Pro Web page.
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DISPLAY

The Display options let you control the way in which your messages will be formatted and displaye
both as they are sent and as they appear in the Message Browser.  

Figure 74: Display panel

General 

Show hot help—Determines whether hot help (pop-up help messages) will be displayed when
the mouse pointer is over a button or displayed option. The delay setting lets you choose the r
time before the help boxes will pop up: Short, Medium, Long, or No. With No delay, the hot help pops 
up immediately.

Hide button titles—If selected, suppresses the display of the titles of individual buttons. 

Hide button edges—If selected, removes the 3D edges of individual buttons.

Hide button separators—If selected, removes the separator bars from between button groups

List Views—Chooses the unique display characteristics for messages as they appear in a list. Yo
set the individual display characteristics to your own preferences.

Message Peek—Chooses the unique display characteristics for message text that appears in the 
sage Peek pane. You can select a Font and Size to suit your own preferences.

Message View—Controls the appearance and behavior of messages as they are handled within th
sage window.
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Show read messages using—Selects the font appearance for read messages that appear in a 
Plain, Bold, Italic, Underline, or Strikethrough. You can also choose a color for the message t

Show unread messages using—Selects the font appearance for unread messages that appear
list: Plain, Bold, Italic, Underline, or Strikethrough. You can also choose a color for the messa
text.

Show deleted messages using—Selects the font appearance for deleted messages that appea
list: Plain, Bold, Italic, Underline, or Strikethrough.

Show server using—Selects the font appearance for messages that have been retrieved with 
Leave mail on server option. Font options include: Plain, Bold, Italic, Underline, or Strikethrough.

BEHAVIOR

The Behavior options control how QuickMail Pro responds to certain tasks, such as forwarding mes
and opening new windows.

Figure 75: Behavior panel

List Views—Controls how folder content is displayed by the program.

Double-clicking a folder opens it in a new window—Displays folder contents in a separate win
dow when the folder is accessed by double-clicking. Otherwise, folder contents are shown in
Message Browser window—messages and other folders are nested below the parent folder.

Close the message window after—Determines what actions result in the message window being 
closed.
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Deleting the message—Closes the message window after a message is deleted.

Filing the message—Closes the message window after a message is filed.

Sending the message—Closes the message window after a message is sent.

When choosing “Forward”, default to—Specifies the options used when forwarding mail.

Forward with changes—Includes any edits or changes that have been made to a message w
is forwarded.

Forward as is—Forward the message in its original state, without edits or changes that have 
made to it.

Redirect—Forwards mail and keeps the originator.

Ask me—Queries you before completing the forwarding operation.

When choosing “Reply”, default to—Controls the handling of message replies.

Reply to sender—Directs mail replies to the contact who sent the mail message (even if it wa
warded from a different source). 

Reply to originator—Directs mail replies to the contact who originated the mail message (not
essarily the same contact who sent it).

Reply to all—Directs mail replies to everyone who appeared in the “From” list, including carb
copy recipients.

Ask me—Queries you to determine how each individual message reply should be handled. Yo
choose the appropriate option when you send the mail.
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FORMS

The Forms panel lets you choose pre-built or self-designed QuickMail Pro forms to exchange with 
QuickMail Pro users. QuickMail Pro offers a collection of custom E-mail forms that can be applie
messages that are sent to other QuickMail Pro users. You can also create your own custom forms
them, and then select them for use from the Forms panel.

Figure 76: Forms options

Use the Install Form button to add pre-built forms or original forms that you have created to the list. 
Clicking this button opens the standard Choose a File dialog. Locate the form file and click Open. Once a 
form has been installed, you can use it in your correspondence with other QuickMail Pro users.

Use the Remove button to delete forms from the list that you no longer want to use. You can reinsta
these forms by clicking the Standard Forms button and then choosing the form name from the list that 
appears.

You can preview available forms from the Message window. Selecting the form name from the fo
bar immediately places that form within the Message window. You can cycle through the collectio
forms by selecting each of the forms in turn for viewing.
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SENDING AND RECEIVING

The Send/Receive options determine how QuickMail Pro handles certain mail delivery and receiv
tasks.

Figure 77: Sending and Receiving

When sending a message . . .—Specifies how QuickMail Pro handles message delivery.

Send immediately—Transmits the message as soon as you click the Send button. If this requires 
that a dial-up connection be made, QuickMail Pro initiates the modem link with the designate
server.

Bcc a copy to self—Sends you a blind copy of each message by return mail for reference or 
archiving. 

Bcc a copy to this address—Sends a blind copy of each message to the specified address, wh
one of your alternate mail addresses or to another E-mail user. 

Compress enclosures—Applies file compression to message attachments. This can be selectively
applied depending on the attachment size. The compression engine used is the StuffIt Engine fro
Aladdin Systems, so this software must be pre-installed and available on your computer before th
pression option can be used.

Only if enclosure is larger than...—Determines the use of compression based on the size of e
attachment. Attachments larger than the value indicated are compressed.

Create Self Extraction Archive (SEA)—Uses the Stuffit Engine to produce a compressed file t
is self-extracting; in other words, the file can be expanded by anyone using a Mac just by do
clicking it.
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When receiving a message . . .—Specifies how QuickMail Pro handles message reception.

Don’t download messages larger than...—Indicates the maximum size of a message, including 
attachments, that QuickMail Pro can retrieve from the server. QuickMail will retrieve a notice 
the large message is on the server. You can then retrieve the message at a later time.

USER OPTIONS

Panels in the User category include:

■ Accounts

■ Signatures

■ Personal vCards

ACCOUNTS

Each account shown in this panel represents one E-mail address associated with the individual c
logged in to QuickMail Pro. You can maintain multiple E-mail addresses for each persona, or use
tity, in QuickMail Pro. For each account, the panel displays a brief summary of the accounts deta
such as the persona name, the frequency of mail checking, and whether the mail is left on the se

Figure 78: Accounts panel

To check account information, highlight the account that you want to change and click Edit. The Edit 
Account dialog appears.
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Figure 79: Edit Account dialog

The options on the Edit Account panel specify account, login, mail checking, and connection informati
The Incoming, Outgoing, and Persona fields are automatically prefilled when setting up a new account w
the Account Assistant.

Include this account with Send and Receive All—Indicates that this account should be checked for
new mail each time a Send and Receive All command is issued from the File menu of QuickMail Pro.

Persona—A set of identification values associated with a user. Each user can have one or more p
nas and each persona indicates a different message originator, with unique name, address, orga
signature, and other similar information.

First/Last Name—Your first and last name.

E-mail Address—Your complete E-mail address as assigned by your ISP or network administrato
example, sara@isp.com.

Signature—The information that you select to be added to the end of each E-mail message auto
cally. The signature might include your name, address, Web site URL, a favorite quotation, teleph
number, or any kind of similar contact information. Signatures can be created and assigned nam
easy access in QuickMail Pro.

 vCard—The name of the vCard data associated with the current persona. A vCard allows contac
mation to be easily exchanged and quickly entered into contact managers.

Add Persona—Creates a new, empty persona that can be filled out by the user. On the new form, 
the additional contact detail and E-mail account that you want to associate with this new persona

Remove Persona—Deletes the persona represented on the currently open panel from the accoun
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Fetch Server Aliases—Retrieves any known aliases for this account from the server. 

POP Account—Your login name as assigned by your QuickMail Pro Server administrator or ISP o
ator. This is often the first and last name with an Internet separator, such as a period or undersco
example, sara.james. It can also be a single name, such as “sales” or “support.”

POP Host—The address of the POP server to which your mail is sent. 

Password—The characters representing the password that you use to access this E-mail account.
not the same as the password you use when you launch QuickMail Pro. If you have several diffe
E-mail accounts, you must set up separate account details with the appropriate password for eac
E-mail account that you access.

Use Secure Password (APOP)—Enables a password encryption standard that is used to make it m
difficult for your password to be intercepted and accessed by unauthorized individuals. 

Check mail every...—Determines the intervals between QuickMail Pro checking for new mail. 

Leave mail on server—Sets QuickMail Pro to download a copy of each mail message, leaving the 
inal on the server until it is deleted from your Inbox or filed to a folder. This option can be useful if
log into the server to check mail from remote locations, but you want to retain your mail on a serv
one central location.

SMTP Host—The address of the SMTP server through which your mail is sent out to the Internet.
entry may be the same as the Incoming Mail POP Host field if one server is used for both incoming and
outgoing mail.

IDENTIFYING YOURSELF TO OTHER USERS

Signatures and vCards let you personalize your messages with specific information that you supp
can create multiple signatures and vCards and assign them to particular personas in QuickMail P
present yourself to contacts in a certain way. For example, you might want to use one vCard for 
your business contacts and another vCard to present to members of an organization to which yo
belong. To add variety to your messages, you can create a group of signatures that will cycle ran
each time you complete a message. 

SIGNATURES

Signatures provide a way to add a distinctive conclusion to each of your messages—without hav
type the information manually. You can use different signatures with different personas. If your si
ture includes a World Wide Web URL, QuickMail Pro automatically converts the URL address into
live link so the message recipient can immediately connect to the address. 
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Figure 80: Signatures

New signatures can be added to the signature list by clicking the Add button. The Add Signature dialog 
appears.

Once you have created signatures, you can apply them to messages by using the Signature pop
ton in the editing bar of the Message window. Signatures are inserted directly after your messag
You can view the individual contents of each signature by clicking the Edit button with the signature 
name highlighted.

Figure 81: Add Signatures

Enter the details of the signature in the text box. The Signature Name that you enter will be displayed in 
the signature list. If you select the checkbox, Include this signature in a random list, the signature will auto-
matically be displayed by random selection as you complete QuickMail Pro messages. For exam
you could create a set of signatures with ten different quotations and these would be applied ran
to messages, adding some variety to your communication.

The Copy from Internet Config button lets you retrieve the content of a signature from the Internet Con
data stored in the QuickMail Pro Utilities folder (based on information retrieved from the Mac OS
This signature can then be applied to new messages that are created.
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PERSONAL VCARDS

If you use a contact manager application, you know how tedious it can be to manually enter and e
personal data for all your contacts. Using vCards, you can provide your personal and business in
tion to your contacts in a standardized form that can easily be imported into vCard-compliant con
managers. You can also import vCard data from E-mail messages that you receive from your con
QuickMail Pro makes it simple to create a vCard. In fact, you can create and store several differe
vCards and select the one to use for any given circumstances or for exchanging information with
ticular contact. 

The personal vCards that you create are displayed in a list that appears when you select the Personal 
vCards panel from the Identity category.

Figure 82: Personal vCards

To create a new vCard, click the Add button. The Add Personal vCard dialog appears. The vCard Name tha
you assign will appear in the vCards list, where you can select it to be attached to an E-mail mes
The rest of the information fields for the vCard should be filled out to reflect those details of your
sonal data that you want to exchange with other E-mail contacts.
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Figure 83: Add Personal vCard

Click OK when done filling out the fields on the vCard form. The vCard you create will be listed by
name with all other current vCards. You can change the information stored in a vCard by selectin
name and clicking the Edit button from the Personal vCards dialog.

To choose a vCard to attach to E-mail message, select Enclose Personal vCard from the Attachment icon 
options available in the Message window. 

To remove a vCard from the list, highlight the vCard name and click the Remove button.

HANDLING RECEIVED VCARDS

When you receive a vCard from one of your contacts, it appears as an attachment in your messag
the vCard icon an address book opened in Contacts Manager to save the data. Many applications
you import the information stored on the vCard. 
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MESSAGE OPTIONS

The Message panels control the appearance of messages that you send and the printing of mes
from the Message Browser. You can also control the options that apply to return receipts.

READING

The Reading options affect properties of a message as you are viewing it. The following options 
available.

Figure 84: Reading options

Show quoted text beginning with “>” using:—Selects a font style and a color for text that has 
been included from a prior message. Style options include: Plain, Bold, and Italic. Color optio
include 15 distinct colors you can use to identify quoted text.

Defaults for non-QuickMail messages—Determines the appearance of messages sent from n
QuickMail recipients.

Form—Chooses the display format for non-QuickMail messages. You can apply QuickMail fo
to non-QuickMail messages, if you prefer the format of one of the pre-existing forms. By defa
this is set to the Plain Memo form.

Size—Selects the font size for mail messages.

Font—Selects the font to use when displaying messages. 

Style—Selects the font style for messages.

Play voice mail automatically—If checked, this option causes voice mail attachments to be pla
as soon as a message is opened. Otherwise, the voice mail playback is controlled by the use
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COMPOSING

The Composing options control the overall appearance of message content, the handling of quoted
tions within a message, and the use of signatures and vCards.

Figure 85: Composing panel

Message Defaults—Controls the appearance of message text.

Form—Selects a form from those available to use as a template for messages.

Size—Specifies the point size of text contained in a new message. 

Font—Designates the font to be used in newly created messages; any font that is installed o
system can be applied to a message—however, messages recipients can only see the mess
same format if they have the same font installed.

Style—Determines the font style of the text within the message.

Quoting—Controls the handling of quoted material from other messages or replies.

Quote the original message—Indicates that the quoted text from the original message should 
included as a part of the reply. Automatically inserts the text cursor above or below the message, as 
you specify.

Use quoting character “>,” when—Inserts the quoting character according to your preference
when you are replying to another message and when you are forwarding a message that ha
modified.

Prepend quote with reference to sender—Inserts a tag line before a quotation included in a me
sage that identifies the original sender of the quoted material.

Add timestamp of original message—Inserts the time and date that the quoted material was c
ated.
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RETURN RECEIPTS

Return receipts provide notification of whether or not messages reach their intended recipient. A
receipt can be generated at the server level, from the server that accepted the message, and fro
individual user when a message is opened and read. You can also choose how you will respond 
receipt requests that arrive in your Inbox.

Figure 86: Return Receipts panel

When addressing a new message—Request receipt by default, if selected, ensures that a receipt request
will be generated automatically when you create and address a new message. Use this option if 
want to receive receipts for all the messages that you send.

When I request a receipt, I want—Specifies the handling of receipts from external servers and ma
recipients.

A delivery receipt from the receiving server (DSN)—Indicates that the server that receives the
message should supply a return receipt.

A read receipt when message is displayed—Requests that a receipt be returned when a messa
is opened and read. This option depends on the recipient of your message (read receipts can
pressed by individual users).

Both—Indicates that a return receipt should be generated by the receiving server and a read
should be returned when the message is opened and read.

When I receive a message and the sender requested a receipt (MDN)—Determines how QuickMail 
Pro responds to requests for incoming mail receipts.

Never return a receipt —Prevents read receipts from being generated under any circumstanc

Always return a receipt—Ensures that read receipts are always sent out when requested. 
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Ask me when I close the message—Lets you individually determine after you have read a messa
whether a read receipt should be sent to the sender.

PRINTING

QuickMail Pro has a number of options for controlling printing, accessible through the Printing pa

Figure 87: Printing panel

Page setup—Determines how QuickMail Pro responds when you begin to print a message.

Show “Page Setup” dialog—Displays the standard page setup dialog for your printer. 

Default print format —Determines whether the internal message formatting is used when printing
whether QuickMail Pro should override the message format using other selections. 

Graphic form—Prints the message using the same form that is used in the Message window

Text only—Select this option to print only text with no graphics.

Address List

Limit the address list to the <number> first items...—Sets an upper limit to the number of recip
ients that should be included in the printout. This is useful if you often have extremely long ad
lists and you do not want to print the full list.
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ADVANCED OPTIONS

These settings include features that are somewhat more technical than other areas of QuickMail 
recommend that only advanced users modify the settings included in the following panels.

While many modern E-mail applications can handle a variety of encoding formats for attachment
some earlier applications are more limited. QuickMail Pro incorporates intelligent attachment han
by extracting details from message headers that identify the originating platform for a message an
using these encoder settings for future message attachment deliveries to the same person.

In some circumstances, you might want to adjust the way encoding options are handled. You hav
option of either adjusting the default settings that are used by QuickMail Pro, or creating new ent
that handle encoding completely differently. 

MAILER ENCODINGS

QuickMail Pro uses the Mailer Encoding settings defined on this panel to determine how to hand
and message attachments for each of the different possible E-mail platforms. In other words, if yo
a message to someone who receives their mail on a Windows 98 computer (and specify that enc
QuickMail Pro will use the settings listed under Windows to format the message. When you are compo
ing a message and you select a recipient from an Address Book, QuickMail Pro uses the data stor
that recipient to determine correct formatting and encoding. If the person was added to the Addre
Book based on information received from an incoming message, in most cases, QuickMail Pro is 
properly identify the client platform and select a suitable encoding method.

When you are entering addresses manually, a pop-up list beside the recipient’s name lets you ch
from one of the five basic encoding types (QuickMail, MacOS, Windows, Unix, and Compatible), 
shown in Figure 88. QuickMail Pro then refers to the settings in this panel when formatting the me
and attachments for delivery. When manually addressing messages in this manner, you are expe
know the appropriate E-mail platform to select.

For the majority of cases, you should never have to modify any of the settings in the Mailer Enco
panel; QuickMail Pro identifies and selects the appropriate settings for you. However, for advanc
users, you have the capability of making any changes required to handle specific circumstances. Y
also create additional mailer encodings to use for specialized mailings.
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Figure 88: Mailer Encodings panel

USING THE COMPATIBLE ENCODING FOR MAC FILES

For many different types of messages and attached files, the Compatible mailer encoding setting works 
without problems. However, using the Compatible setting with certain kinds of Macintosh files can crea
difficulties. This is because of the structure of the Macintosh file format, which differs from typica
and UNIX file formats. The primary difference is that a Macintosh file includes both a resource for
a data fork, unlike PC/UNIX files, as shown in Figure 89.

Figure 89: Macintosh file format compared to PC/UNIX format

The data fork in a Macintosh file contains the basic binary application data or text data, dependin
the type of file. The resource fork identifies the data content and provides important details abou
data. If the file is an application, the information stored is typically resources that describe the ap

Macintosh file PC/UNIX file

FILENAME.SUFFile Name

'Text'

'ttxt'

00100001
11010000
10101000
00011110
11111000

00100001
11010000
10101000
00011110
11111000

File Type

File Creator

Resource Fork

Data Fork
Data

File Suffix
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tion’s icons, dialogs, menus, or executable code. Resource forks for document files typically con
preference settings, window locations, fonts, icons, and so on. The Macintosh Finder uses the re
fork to display the appropriate file icon.

When the Compatible setting is selected for a message transfer with an attachment that includes a M
tosh file, the data fork is sent, but not the resource fork. The loss of information creates problems
are sending applications or even sometimes if you are sending documents. To avoid the problem
one of the encoding options that suits the Macintosh platform. If you are sending a file to a recipi
who is using QuickMail Pro on the Macintosh, you can choose the QuickMail Pro option. Or, you
choose the Mac OS option. In both cases, file attachments can be transmitted securely and with
errors.

ADDING AN ENCODING SETTING

If you have an application that requires a custom encoder setting, you can create it as follows.

To add an encoder setting:

1 From the Mailer Encoding panel of the Preferences window, select Add. The Add Mailer Encoding dialog 
appears.

Figure 90: Add Mailer Encoding dialog

2 Enter a name for the Encoding method. This is the name that will appear in the Mailer Encoding panel 
for editing and selection.
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3 Select a Form Encoding to use if intended recipients are QuickMail Pro users. The QuickMail Pro
selection ensures that forms get transmitted properly along with the message. For other plat
select No Form.

4 Set the characteristics of the Text Encoding. You can select either HTML text or Plain Text, an
can choose from among several character set options ranging from simple 7-bit ASCII text to
nese variations. 

5 Choose a Byte Encoding method for text, which determines what method of storage and compres
is used when converting the message text to a format for transmitting. This selection should 
compatible with a method that is in use by the intended recipients, so that the text can be pr
converted from its encoded format when received. Refer to “Text Encoding” on page 26 for m
details on this topic.

6 Select a File Format to use for attachments. These file formats enable attachments containing b
data to be transmitted across the Internet; recipients should be able to extract this data using
mail client or a utility, such as StuffIt Expander. Refer to “Encoding Options” on page 26.

7 Choose a Byte Encoding method for attachments. This selection should be compatible with a me
that is in use by the intended recipients, so that the attachment can be properly decoded wh
received. Refer to “Attachment Encoding” on page 26 for more details on this topic.

8 Click OK when done to save your selections and create a new Mailer Encoding entry.

MAILER MAPPINGS

Mailer Mappings create associations between patterns that appear in the X-Mailer entry in the he
an E-mail message and the Mailer Encoding that QuickMail Pro identifies with that pattern. This 
enables QuickMail Pro to collect data from incoming mail messages and determine the appropria
encoder settings to use for a recipient who has sent a mail message. As you add recipients to an
Book through Contacts Manager, QuickMail Pro identifies the appropriate encoding to use and st
along with the contact data. 

Under normal circumstances, you should not need to change the entries on this panel, but you h
flexibility to do so if you need to adapt QuickMail Pro for a specialized application. You can also c
additional Mailer Mappings to correspond with custom Mailer Encoding settings that you create (
described in “Adding an Encoding Setting”). 
100 Chapter 4



in 
pecific 

ates. 

*) to 
ions 
Figure 91: Mailer Mappings

ADDING MAILER MAPPINGS

You can create additional mailer mappings to allow QuickMail Pro to recognize specific patterns 
incoming messages, enabling the application to form associations between an X-Mailer entry or s
domain and a type of Mailer Encoding.

To add a new mailer mapping:

1 From the Mailer Mappings panel, click the Add button. The Add Mailer Mapping dialog appears.

Figure 92: Add Mailer Mappings

2 Choose whether the Mailer Mapping is to be based on the X-Mailer Header Field (which is 
extracted from incoming E-mail messages) or from the domain from which a message origin

3 Enter the pattern that you want QuickMail to recognize. You can use the wildcard character (
extend the range of valid matches. For example, if you want the application to look for variat
on Windows (windows95, windows98, windowsNT), you could enter *win* for the pattern.
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4 Choose the Mailer Encoding method that you want to associate with this Mailer Mapping. QuickM
Pro will make this association each time it identifies matching strings and it will store the enco
type specified as part of the recipient data.

5 Click OK when done to create the new mapping.

PAGER & FAX

The capabilities of basic E-mail have been extended with pager and facsimile services through Q
Mail Pro. Access to these features depends on the availability of a gateway that supports E-mail a
ing to pagers, cellular phones, and fax equipment. If your E-mail is handled by QuickMail Pro Se
you automatically have access to such a gateway. E-mail messages ending in @telenote are rer
the Telenote Server for QuickMail. Messages are then converted to Short Message Service (SM
mat, which can be effectively transmitted through phone lines to reach cellular phone networks. M
sages originating on the computer can be routed to cell phones, pagers, and faxes in this manne

SMS is widely available throughout Europe and is gaining popularity in the United States, as wel
Check with your carrier to find out about availability in your region. Note that the formatting of E-m
messages is very specific for each of these services; you must use the appropriate E-mail forma
instructed by the service offering the gateway, to properly reroute and deliver messages in these 

The Pager & Fax panel options essentially turn on and turn off these capabilities in QuickMail Pro
also have the ability to control character formatting within the number that is used to access the s

Figure 93: Pager and Fax options

Pager Messages—Controls the options associated with sending E-mail messages to pagers that s
message reception. 

Enable email addressing to pagers—Allows E-mail messages to be sent through gateways to p
ers that can handles message reception. 
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Strip non-digit characters from number—Eliminates any characters in the number that contai
alphabetic characters.

Format—Indicates the format that applies to the gateway service, as provided by the gateway
ator. Check with your provider for the appropriate format.

Enable email addressing to cellular phones (SMS)—Allows E-mail messages to be directed 
through a gateway to cellular phones that are equipped to receive messages. 

Strip non-digit characters from number—Eliminates any characters in the number that contai
alphabetic characters.

Format—Indicates the format that applies to the gateway service, as provided by the gateway
ator. Check with your provider for the appropriate format.

Fax Messages—Controls the sending of E-mail data to fax machines.

Enable email addressing to faxes—Allows E-mail messages to be converted and sent through
gateways to facsimile equipment.

Strip non-digit characters from number—Eliminates any characters in the number that contai
alphabetic characters.

Format—Indicates the format that applies to the gateway service, as provided by the gateway
ator. Check with your provider for the appropriate format.
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CHAPTER 5: SEARCH OPTIONS

QuickMail Pro includes a versatile search engine that can locate names, words in the subject or b
messages, and messages that fit other criteria. Searches can include all of the folders in your ma
tem or can be narrowed just to hunt through your Inbox or another folder. At startup, the Search feature 
returns to the default setting of Find messages in all folders matching any criteria.

STARTING A SEARCH 

Searches can be quickly launched from the Message Browser window. For a full description of th
search options, refer to “Improving Your Search Results” on page 106.

1 Click the Find option from the Edit menu. Or, select the Search button from the Message Browser 
button bar. The QuickMail Search dialog appears.

Figure 94: QuickMail Search dialog

2 Choose the folders to include in the search in the Find messages in pop-up menu.

3 Choose the criteria to apply to the search in the matching pop-up menu.

4 Specify the actual part of the message to search using the pop-up menu on the next line. Fo
ple, choose to search the subject lines of messages that contain the word “conference.” 
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5 If you want to add an additional item to search, click the More button. 

Figure 95: Searching through message text

6 Click Find to start the search. The search results appear in the Browse pane, where they can
sorted by Subject, Sender, and Date Sent by clicking on the appropriate column heading. You can al
view the message contents from this pane.

IMPROVING YOUR SEARCH RESULTS

Finding the information that you are seeking often requires specifying your search parameters in
that will yield the most effective results. If your attempted search yields few results or no results a
you need to change the search parameters to broaden the search. If the search returns so many r
you cannot easily scan through them all, you want to change the search parameters to narrow the

FIND MESSAGES IN

The first line in the Search window (Find messages in) lets you narrow or broaden a search in two separ
ways:

■ Selecting the folders to search

■ Selecting whether the search must match all specified criteria or any of the criteria 

Use the More button to add another set of criteria to include in a search.

SELECTING FOLDERS
The range of folders selected to include in the search will either narrow or broaden the search re
The following options appear by dropping down list labeled all folders: 

■ all folders: searches all of the mail folders that can be viewed from the Message Browser. T
includes the Inbox, Outbox, Trash, Drafts, all personal folders, and all other folders. This
options provides the most complete search results.
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You can narrow the search results by limiting the search to one folder. For example, you can sea
of the following folders:

■ Inbox: searches only the contents of the Inbox folder

■ Outbox: searches only the contents of the Outbox folder

■ Sent Mail: includes messages in the Sent Mail folder in the search results

■ My Filed Mail: searches previously archived messages in the folder designated My Filed Mail

QuickMail Pro also lets you choose from folders that apply to a specific account. For example, as 
in Figure 96, you can select the Joe Smith account or the Joe Smith, Jr. account to conduct a search. If you
choose an account name in this manner, QuickMail Pro searches through all of the primary folde
ciated with the account, including the Inbox, Outbox, Sent Mail, Receipts, and any shared mailbo
that have been defined.

Figure 96: Selecting folders to search

SELECTING CRITERIA
Selecting the criteria to use in the search also influences the range of the search results.

To broaden the search results, choose the any criteria option. With any criteria selected, the search engine
returns results for any matches of terms or dates or senders—any specified criteria that have been
This technique generates the most search results.

To narrow the search results, choose the all criteria option. With all criteria selected, the search engine onl
returns messages that match every one of the specified criteria. You can use this option to precise
specific messages that you want to view or access.
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MORE CHOICES

Click the More Choices button to display an additional line of search options. You do not need to ent
select criteria in every field. Fields that are left blank are ignored during searches. Set up the matching 
value to any criteria to expand the search results and all criteria to narrow the search results.

Figure 97: More search choices

Each of the two lines includes identical options. Select one of the criteria—subject, sender, or other 
item—on each line and than specify whether the indicated search item contains or doesn’t contain the word 
or text string that will be entered in the text field. 

For some items, such as date sent, priority, and status, the final criteria selection is limited to only those 
options from a drop-down list that apply. For example, if you select priority, a drop-down list limits
criteria to Urgent, Normal, or Bulk. Similarly, date sent displays a selection list for choosing a date. If you
choose status, your selections are limited to the message status indicators (read, flagged, deleted, answered, 
or forwarded).

Using the doesn’t contain option excludes the specified terms from the search results. You can use it
filter to avoid getting certain messages included in the search results. For example, if you want to
matches of messages from a person named Cyril Washburn, set one of the criteria lines to read:sender 
doesn’t contain Cyril Washburn. 
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SEARCH RESULTS DIALOG

You can view search results while the search is still in progress. 

The Progress bar displays the progress of the search. The number of messages found displays to 
of the Progress bar and updates as matches are made. Clicking the Message Peek icon in the lowe
corner of the Message Browser lets you view the message contents in the bottom pane, as show
Figure 98.

Figure 98: Search results

Sorting columns

Search results pane

Search criteria

Status line

Message Peek pane

Message Peek icon
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SORTING MESSAGES FROM SEARCH RESULTS

The Search Results pane contains a message list. Messages in this list are sorted by the category h
lighted in the category bars above the list: Priority, Message Status, Subject, Who, and Date Sent. Click a cat-
egory to sort the message list according to a particular view. For example, click the Date Sent button to 
sort the messages sequentially by the date each message was sent.

To open a message displayed in the list for viewing, double-click the message subject or highligh
message and click the Read button. The message contents are displayed in a separate window. 

Messages that are highlighted in the search results list can be handled using the buttons along th
the window. You can perform any of the following actions on a message:

■ Read: displays the contents of a message in a separate window

■ File: lets you file the message in a selected folder

■ Delete: removes the message and places it in the trash

If you open a message for viewing, you can also Forward it to another party or respond to the message
using the Reply feature.
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CHAPTER 6: MAILMANAGER

MailManager™ is a tool that automatically handles incoming and outgoing messages, allowing you
file, print, forward, or delete messages based on a flexible set of criteria. For example, when you
vacation you can create a Rule that automatically replies to all incoming mail with a statement th
will return from vacation in one week. In the interim, MailManager can file incoming messages in
“Vacation” folder, making it easy for you to view new mail when you return. 

MailManager offers two sets of rules: Server Rules and Client Rules. Server Rules handle mail a
server and Client Rules handle mail downloaded to your desktop computer. You can use both typ
rules to precisely specify how both the server and the client respond to messages sent to your E
address. 

❖ Note: Server MailManager Rules are available only if QuickMail Pro Server 2.0 software is use
your mail server. 

CONFIGURING MAIL MANAGER

To set up rules for handling your mail, launch QuickMail Pro and select MailManager from the Tools 
menu. The QuickMail MailManager window displays. This window is your starting point for anyth
you do with MailManager; you can choose a Rule Set, enable or disable rules, choose to create 
rules, choose to edit existing rules, or delete rules.

Figure 99: QuickMail MailManager window
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CREATING CLIENT RULES

1 Select MailManager in the Tools menu to display the QuickMail MailManager window shown in 
Figure 99.

2 Select Client Rules from the Rule Set pop-up menu.

3 Click the New button. The Rule Properties dialog appears. 

Figure 100: Rule properties dialog

4 Type a name for the rule in the Rule Name field. For example, type Rule #1 at the prompt. 

❖ Note: Each Rule name must be unique.

5 Select the Incoming, Outgoing, or Manual checkbox to specify when you want the rule applied.  

■ Incoming:applies the rule to incoming mail

■ Outgoing: applies the rule to outgoing mail. 

■ Manual: applies the rule only when you choose one or more messages in the Message Br
and select the Apply Rules option from the Tools menu. You can also manually trigger rules by 
selecting Apply Rules from the contextual menu that appears when you Control-click the 
selected messages.

6 Specify the criteria messages must meet before MailManager processes them. You can expa
criteria by clicking the More Choices button and selecting additional search parameters. See 
page 114 for detailed information on the available criteria. 

7 Click the Stop processing more rules checkbox if you want MailManager to stop processing rules on
a set of criteria has been met for a particular message. 
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8 Click the Add button when you are finished specifying the criteria for the rule. The Client Action win-
dow appears. 

Figure 101: Client Action window

9 Choose an action for the rule and specify any additional information the selected action requ
See page 116 for information on each available action.

10 Click OK when you are done selecting an action. The defined action appears in the Rule Properties 
dialog.

11 Specify any additional actions you want the rule to perform by clicking the Add button and selecting 
another option from the Action pop-up menu. For example, you might want to have MailManage
both file and print each message that matches the criteria. Click OK in the Client Action dialog when 
you are finished.

12 When you are done specifying the actions that apply to the rule, click the close box in the Rule Prop-
erties dialog. 

13 Click Save at the prompt to save the rule you just created. The new rule appears in the QuickMail Mail-
Manager window along with a check mark next to your processing choices (Incoming, Outgoin
Manual processing). A check mark appears in the Stop column of the QuickMail MailManager window 
if you selected the Stop processing more rules checkbox shown in Figure 100.

14 Click the Start Client Rules check box to enable the rules you have created.

The Rules you create are stored in your :System Folder:CE Software:QuickMail Internet:Users:
<username>:Rules folder. Your Client Rules are not available from other workstations.

❖ Note: MailManager Actions ignore your Preferences settings, such as Always send copy to self.
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CLIENT-BASED CRITERIA

When you are creating client MailManager rules, the criteria you specify can either narrow or exp
the range of messages that MailManager processes. 

ANY CRITERIA
If you select any criteria, messages that contain any of the search criteria you specified are process
MailManager. This option is equivalent to a Boolean “OR“, in logical terms. For example, assume
you have set three criteria:

■ Subject contains “tropical gardens”

■ Message text contains “tropics”

■ Message text contains “gardens”

If “tropical gardens” displays in the subject line or “tropics” or “gardens” are present in the messa
text, MailManager performs the designated action on the message.

ALL CRITERIA
If you select all criteria, messages must contain each and every one of the search criteria that you in
before MailManager will process the messages. This option is equivalent to a Boolean “AND“, in 
cal terms. For example, assume that you have set two criteria:

■ Subject contains “alternative energy”

■ Sender contains “Rocky Mountain Institute”

For a match to occur, “alternative energy” must appear in the subject and the sender must contain 
“Rocky Mountain Institute.” If these two criteria are met, MailManager performs the designated a
on the message. 

ALL MESSAGES
When you select all messages from the Apply actions... pop-up menu, the action(s) you specified are 
performed on each message that arrives in your Inbox or that is sent from your Outbox. You do no
to specify any criteria if you select the all messages option.

ADDRESS
When address is selected in the first pop-up menu, eight different options become available in the se
pop-up menu.

■ sender—Examine the message headers of incoming or outgoing mail for a particular nam
E-mail address. The text is also matched with any substring in the person’s name or add

Some examples of legal matches for a search “John” include: John Smith, 
John.Smith@xyz.com and John.Doe@smith.com

■ reply-to—Examines the message headers of outgoing mail for a particular name or E-ma
address.
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■ from—Examines the message headers of incoming mail for a particular name or E-mail 
address in the “from” field.

■ to—Examines the message headers of incoming or outgoing mail for a particular name o
mail address in the “to” field.

■ cc—Examines the message headers of incoming mail or outgoing mail for a particular na
E-mail address in the “cc” field.

■ to/cc—Examines the message headers of incoming or outgoing mail for a particular nam
mail address in the “from” or “cc” fields.

■ SMTP sender—Examines the transport address of incoming mail for a particular name o
mail address. For example, selecting this option would enable MailManager to look at the
sender of a listserver message. Even though the “From” field would only show the listserv
the sender, the transport address would reveal the true sender of the message.

■ SMTP recipient—Examines the transport address of incoming or outgoing mail for a parti
name or E-mail address. 

SUBJECT
When subject is selected in the first pop-up menu, you must use the second pop-up menu to choo
whether the subject field of a message contains or doesn’t contain the specified word or text string in the 
messages‘ Subject fields.

MESSAGE TEXT
When message text is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the message text contains or doesn’t contain the specified word or text string.

DATE SENT
When date sent is selected in the first pop-up menu, you must use the second pop-up menu to cho
whether the message was sent on, before, after, or on a different day than the specified date. Use
field‘s scroll arrows to choose a particular month, day, and year.

 PRIORITY
When priority is selected in the first pop-up menu, you must use the second and third pop-up men
choose whether the message priority is or is not set to Urgent, Normal, or Bulk. 

 STATUS
When status is selected in the first pop-up menu, you must use the second and third pop-up menu
choose whether the status of the message is or is not set to read, flagged, deleted, or forwarded. The answered 
status option is present for future versions of QuickMail Office when IMAP is more fully implemen

FOLDER NAME
When folder name is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the name of the folder contains or does not contain the folder you specified in the provided text field
This option is primarily used for incoming mail when you have multiple Inboxes.
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MAILMANAGER
When MailManager is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the MailManager rule you selected from the third pop-up menu matches rule or doesn’t match rule. 
This option is especially useful for more complex MailManager queries. Only Client Rules display i
MailManager rule pop-up menu.

CLIENT-BASED ACTIONS

Once you select the criteria for a rule and click the Add button, you are prompted to choose which actio
MailManager performs when processing messages. This section provides information on each o
options available in the Client Action window (shown in Figure 101).

Delete—Removes the message after all other Actions have been processed.

File—Files the messages in the mail folder you specify. If you check the Make Duplicate checkbox, a 
copy of the original message is filed and the original remains in its current location. Click OK when you 
are finished with the file action.

Print —Sends the message to the printer currently selected in the Chooser. Specify whether you
the message printed in graphic or text-only format. If you choose to have a cover page printed w
message, type the cover page text you want used in the Cover Text field. The cover page option is espe-
cially useful if you share your printer with several other people.

For more details about print options, refer to “Printing” on page 96.

Forward—Sends messages that have met MailManager’s criteria to the recipient you specify. To
ify a recipient, you can either type out the address in the address field or use the following instru
to extract the address from the Contacts Manager.

1 Click the Recipient List button. The Contacts Manager appears

2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.

3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard. 

4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again 
be in the foreground.

5 Click in the address field and paste the address from your clipboard. 

6 Type the message text you want to include in the forwarded message in the Forward Text field.

7 Click OK when you are done.

Reply—Sends messages that have met MailManager’s criteria to the original sender or to all the
ents of the original message. Type the message text you want to include in the reply in the Reply Text 
field. You can include the text of the original message by selecting the Insert Original Text checkbox. Click 
OK when you are done. 
116 Chapter 6



owser 

nd the 

ce 
CREATING SERVER RULES

1 Select MailManager in the Tools menu to display the QuickMail MailManager window shown in 
Figure 99.

2 Select Server Rules from the Rule Set pop-up menu.

3 Click the New button. The Rule Properties dialog appears. 

Figure 102: Rule properties dialog

4 Type a name for the rule in the Rule Name field. For example, type Rule #2 at the prompt. 

❖ Note: Each Rule name must be unique.

5 Select the Incoming, Outgoing, or Manual checkbox to specify when you want the rule applied. 

■ Incoming: applies the rule to incoming mail

■ Outgoing: applies the rule to outgoing mail. 

■ Manual: applies the rule only when you choose one or more messages in the Message Br
and select the Apply Rules option from the Tools menu. You can also manually trigger rules by 
selecting Apply Rules from the contextual menu that appears when you Control-click the 
selected messages.

6 Specify the criteria messages must meet before MailManager processes them. You can expa
criteria by clicking the More Choices button and selecting additional search parameters. See 
page 119 for more information on the available criteria. 

7 Click the Stop processing more rules checkbox if you want MailManager to stop processing rules on
a set of criteria has been met for a particular message. 
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8 Click the Add button when you are finished specifying the criteria for the rule. The Server Action win-
dow appears. 

Figure 103: Server Action window

9 Choose an action for the rule and specify any additional information the selected action requ
See page 121 for more information on the available actions.

10 Click OK when you are done selecting an action. The defined action appears in the Rule Properties 
dialog.

11 Specify any additional actions you want the rule to perform by clicking the Add button and selecting 
another option from the Action pop-up menu. For example, you might want to have MailManage
both redirect and delete each message that matches the criteria. Click OK in the Client Action dialog 
when you are finished.

12 When you are done specifying the actions that apply to the rule, click the close box in the Rule Prop-
erties dialog. 

13 Click Save at the prompt to save the rule you just created. The new rule appears in the QuickM
MailManager window along with a check mark next to your processing choices (Incoming, O
ing, or Manual processing). A check mark appears in the Stop column of the QuickMail MailManager 
window if you selected the Stop processing more rules checkbox shown in Figure 102.

The Rules you create are stored in your :System Folder:CE Software:QuickMail Internet:Users:
<username>:Rules folder. Your server-based Rules are applied to your electronic mailbox regard
which computer you use to retrieve E-mail.

❖ Note: MailManager actions ignore your Preferences settings, such as Always send copy to self.
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SERVER-BASED CRITERIA

When you are creating server MailManager rules, the criteria you specify can either narrow or ex
the range of messages that MailManager processes. 

ANY CRITERIA
If you select any criteria, messages that contain any of the search criteria you specified are process
MailManager. This option is equivalent to a Boolean “OR“, in logical terms. For example, assume
you have set three criteria:

■ Subject contains “tropical gardens”

■ Message text contains “tropics”

■ Message text contains “gardens”

If “tropical gardens” displays in the subject line or “tropics” or “gardens” are present in the messa
text, MailManager performs the designated action on the message.

ALL CRITERIA
If you select all criteria, messages must contain each and every one of the search criteria that you in
before MailManager will process the messages. This option is equivalent to a Boolean “AND“, in 
cal terms. For example, assume that you have set two criteria:

■ Subject contains “alternative energy”

■ Sender contains “Rocky Mountain Institute”

For a match to occur, “alternative energy” must appear in the subject and the sender must contain 
“Rocky Mountain Institute.” If these two criteria are met, MailManager performs the designated a
on the message. 

ALL MESSAGES
When you select all messages from the Apply actions... pop-up menu, the action(s) you specified are 
performed on each message that arrives in your Inbox or that is sent from your Outbox. You do no
to specify any criteria if you select the all messages option.

ADDRESS
When address is selected in the first pop-up menu, eight different options become available in the se
pop-up menu.

■ sender—Examine the message headers of incoming or outgoing mail for a particular nam
E-mail address. The text is also matched with any substring in the person’s name or add

Some examples of legal matches for a search “John” include: John Smith, 
John.Smith@xyz.com and John.Doe@smith.com

■ reply-to—Examines the message headers of outgoing mail for a particular name or E-ma
address.
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■ from—Examines the message headers of incoming mail for a particular name or E-mail 
address in the “from” field.

■ to—Examines the message headers of incoming or outgoing mail for a particular name o
mail address in the “to” field.

■ cc—Examines the message headers of incoming mail or outgoing mail for a particular na
E-mail address in the “cc” field.

■ to/cc—Examines the message headers of incoming or outgoing mail for a particular nam
mail address in the “from” or “cc” fields.

■ SMTP sender—Examines the transport address of incoming mail for a particular name o
mail address. For example, selecting this option would enable MailManager to look at the
sender of a listserver message. Even though the “From” field would only show the listserv
the sender, the transport address would reveal the true sender of the message.

■ SMTP recipient—Examines the transport address of incoming or outgoing mail for a parti
name or E-mail address. 

SUBJECT
When subject is selected in the first pop-up menu, you must use the second pop-up menu to choo
whether the subject field of a message contains or doesn’t contain the specified word or text string in the 
messages‘ Subject fields.

MESSAGE TEXT
When message text is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the message text contains or doesn’t contain the specified word or text string.

DATE SENT
When date sent is selected in the first pop-up menu, you must use the second pop-up menu to cho
whether the message was sent on, before, after, or on a different day than the specified date. Use
field‘s scroll arrows to choose a particular month, day, and year.

 PRIORITY
When priority is selected in the first pop-up menu, you must use the second and third pop-up men
choose whether the message priority is or is not set to Urgent, Normal, or Bulk. 

 STATUS
When status is selected in the first pop-up menu, you must use the second and third pop-up menu
choose whether the status of the message is or is not set to read, flagged, deleted, or forwarded. The answered 
status option is present for future versions of QuickMail Office when IMAP is more fully implemen
120 Chapter 6



hoose 
. 

hoose 

n the 

n 
f the 

r. For 
e 
 instead 
 the 
m 

 spec-
FOLDER NAME
When folder name is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the name of the folder contains or does not contain the folder you specified in the provided text field
This option is primarily used for incoming mail when you have multiple Inboxes.

MAILMANAGER
When MailManager is selected in the first pop-up menu, you must use the second pop-up menu to c
whether the MailManager rule you selected from the third pop-up menu matches rule or doesn’t match rule. 
This option is especially useful for more complex MailManager queries. Only Client Rules display i
MailManager rule pop-up menu.

SERVER-BASED ACTIONS

Once you select the criteria for a rule and click the Add button, you are prompted to choose which actio
MailManager performs when processing messages. This section provides information on each o
options available in the Server Action window (shown in Figure 103).

Delete—Removes the message after all other Actions have been processed.

Redirect—Sends the message to a different recipient, retaining the address of the original sende
example, if you get a message from the sales@yourcompany.com account and you redirect the messag
to your sales manager, the sales manager can reply directly to the original sender of the message
of to you. To specify the recipient of a redirected message, you can either type out the address in
address field of the Redirect action window or use the following instructions to extract the address fro
the Contacts Manager.

1 Click the Recipient List button. The Contacts Manager appears

2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.

3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard. 

4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again 
be in the foreground.

5 Click in the address field and paste the address from your clipboard. 

6 Click OK when you are done.

Forward—Sends messages that have met MailManager’s criteria to the recipient you specify. To
ify a recipient, you can either type out the address in the address field of the Forward action window or 
use the following instructions to extract the address from the Contacts Manager.

1 Click the Recipient List button. The Contacts Manager appears

2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.

3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard. 
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4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again 
be in the foreground.

5 Click in the address field and paste the address from your clipboard. 

6 Type the message text you want to include in the forwarded message in the Forward Text field.

7 Click OK when you are done.

Reply—Sends messages that have met MailManager’s criteria to the original sender or to all the
ents of the original message. Type the message text you want to include in the reply in the Reply Text 
field. You can include the text of the original message by selecting the Insert Original Text checkbox. Click 
OK when you are done. 

Notify—Sends the sender information, the subject line, or the message body of processed mess
the specified address. For example, if you have QuickMail Pro Server’s pager capabilities configu
and you have a pager gateway, you can set up MailManager to forward the subject line of urgent
sages from your parent company directly to your pager.

TURNING RULES ON AND OFF

You can turn off MailManager Rules individually or you can turn off the MailManager function com
pletely, effectively disabling all of your rules.

DISABLING INDIVIDUAL RULES

To disable individual MailManager Rules:

1 Open the Rule Properties dialog (shown in Figure 102). 

2 Clear the Incoming, Outgoing, and Manual check boxes.

3 Click the Rule Properties close box and click Save at the prompt. The rule you disabled will not be 
available until you again check one of the three check boxes in the Rule Properties dialog.

DISABLING ALL CLIENT OR SERVER RULES

There are two ways to disable all the available client or server Rules: from the Tools menu and in the 
QuickMail MailManager window (shown in Figure 99). 

USING THE TOOLS MENU

Select Stop Client MailManager or Stop Server MailManager from the Tools menu to stop applying the client 
and/or server Rules. To restart MailManager at the client level, select Start Client MailManager from the 
Tools menu. To restart filtering at the server level, select Start Server MailManager from the Tools menu. 
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USING THE QUICKMAIL MAILMANAGER WINDOW

Select MailManager from the Tools menu and clear the Start Client Rules and/or Start Server Rules check boxes. 
Click the close box in the QuickMail MailManager window to save your changes.

PROCESSING MESSAGES

You can have MailManager process incoming and outgoing mail automatically or manually. The r
that have the Incoming or Outgoing check boxes (shown in Figure 102) selected in the Rule Properties dialog 
process messages automatically. However, if the Manual check box is selected for one of your rules, th
rule can only be processed when you manually trigger MailManager.

To manually process messages: 

1 Highlight the messages you want to process.

2 Select Apply Rules in the Tools menu. The message list is processed according to the currently 
enabled MailManager rules.

MailManager processing stops only after the selected messages have been processed. 

❖ You can also select multiple messages and press the Control key to display a contextual me
Select Apply Rules from the contextual menu to apply MailManager rules to the selected messa

EDITING MAILMANAGER RULES

1 Select MailManager in the Tools menu to display the QuickMail MailManager dialog.

2 Select a Rule Set from the pop-up menu.

3 Select a Rule and click Edit to display the Rule Properties dialog.  
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Figure 104: Rule properties dialog

4 If necessary, edit the criteria for the rule.

5 If necessary, click the Add button to change the action for the rule. Click OK when you are done 
changing the rule action.

6 Click the Rule Properties dialog’s close box and click Save at the prompt to store the edits that y
have made to the rules.  
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CHAPTER 7: QUICKMAIL PRO UTILITIES

QuickMail Pro installs a number of utilities and on your hard drive: QM Networker, QM Pro Menu
QM MailTicker, and Mac Converters. This chapter discusses each utility and how to use it.

QUICKMAIL NETWORKER

Each time you launch QuickMail Pro, the background utility, QuickMail Networker is also launche
Networker monitors the network for new mail and retrieves messages according to the schedule t
set up. You can also manually send messages through Networker or initiate a check for new mai
Networker remains running even after you close QuickMail Pro, unless you deliberately Quit from it or 
Logout. 

When QuickMail Pro Networker is actively sending or retrieving mail, a status indicator appears a
displays the progress. Select a Send & Receive option from the File menu to begin sending or receiving
mail. 

To send mail:

1 Select QM Pro Networker from the Macintosh Application menu. 

2 From the File menu, select Send Mail Now. Or, press the c-S keys. Networker sends any messages
waiting in your Outbox.

To receive mail:

1 Select QM Pro Networker from the Macintosh Application menu. 

2 From the File menu, select Check Mail Now. Or, press the c-M keys. Networker transfers any incom
ing messages to your Inbox.

To quit QM Pro Networker, select Quit from the File menu or press the c-Q keys.

❖ Note: “Quit” is disabled if the client is open.
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QM PRO MENU

The QM Pro Menu is an extension that allows you to control QuickMail Pro from the menu bar of
your Macintosh. 

Figure 105: QM Pro Menu options

Open QuickMail Pro—Launches the QuickMail Pro application.

Close QuickMail Pro Client—Closes the QuickMail Pro application. This option is enabled when 
Quickmail Pro application is launched.

■ Close QM Networker—Closes the QM Networker application. This option is enabled only
when the QuickMail Pro client is not running.

Acknowledge Notification—Halts the blinking icon or audible tone when new or unread mail exists
the Inbox.

Check Mail Now—Initiates a connection to the POP server to retrieve mail.

Send Mail Now—Initiates a connection to the SMTP server to send mail waiting in your Outbox.

QuickSend—Opens the QuickSend form so you can quickly type and send a message. For more
mation, refer to “Using Quicksend” on page 17.

Send Selection—Creates a QuickMail Pro message filled with text you highlighted in another app
tion or the contents of your Clipboard.

Send Recent Document—Searches for your most recent documents and prompts you to enclose o
a message.

Reformat Text—Removes carriage returns and extra spaces in highlighted text in any application

Quote Text—Inserts quote characters in highlighted text in the active application.

Open MailTicker—Launches the MailTicker application discussed in the next section.
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About QuickMail Pro Menu —Displays the version and copyright information for QuickMail Pro 
Menu.

QM MAILTICKER

The MailTicker is an application that displays the sender and subject line of your primary accoun
Inbox messages in a ticker dialog.

WHAT YOU NEED

The QM Networker must be running for the MailTicker to display your mail. If MailTicker is launch
and QM Networker is not launched, the MailTicker displays Not logged in.

MailTicker only works with QuickMail Pro. It does not work with QuickMail Express or any other 
E-mail product.

USING MAILTICKER

To open a message, double-click it in the MailTicker dialog.You can close the QuickMail Pro application
at any time, and MailTicker continues to display mail as it arrives in your Inbox. 

To launch QuickMail Pro from the MailTicker, click the QuickMail Pro icon on left side of the 
MailTicker window. You can move the ticker window to any location on your screen. 

Figure 106: QM Pro MailTicker

SIZING THE MAILTICKER DIALOG
Position your cursor on the black square in the lower right corner of the MailTicker, and drag to si
dialog. 

THE MAILTICKER MENU
Option-click the QuickMail Pro icon in the MailTicker window to display the MailTicker menu.

VIEWING MESSAGES WITH MESSAGE PEEK
Option–click a message in the MailTicker to view the Message Peek pane. This feature allows yo
scan the content of the message and decide whether or not to launch QuickMail Pro to read you

Click the QuickMail Pro 
icon to display the 
MailTicker menu.

Option-click a message to 
view the first few lines of 
message text.
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MAILTICKER PREFERENCES

Use the Preferences window to control which messages the MailTicker displays, and how quickly the
messages cross your ticker window.

Figure 107: QM Pro MailTicker Preferences

All Messages—Displays all messages in your Inbox.

Unread messages—Displays only the messages in your Inbox you have not read.

Show Return Receipts—Displays return receipts from sent messages.

Hide ticker window when nothing to show—Closes the MailTicker window until new mail arrives in
your Inbox.

Scrolling Speed—Controls the speed at which messages cross the MailTicker window. Choose Slow, 
Moderate, or Fast.

CLOSING MAILTICKER

Click the close box to close MailTicker. You can also Option-click the QuickMail Pro icon in the 
MailTicker dialog and select Quit from the MailTicker File menu that appears at the top of your screen
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QUICKMAIL PRO CONVERTER

The QuickMail™ Pro Converter provides a secure, automated solution for accessing QuickMail™ LAN 
Mac OS files in QuickMail Pro for Mac OS. Use the Converter to copy your filed mail, E-mail, add
books and groups and forms from QuickMail LAN 3.5 or later to QuickMail Pro. Your LAN files ar
untouched at the end of the conversion. 

REQUIREMENTS

Read the following information before proceeding with your conversion to QuickMail Pro.

■ Files cannot be converted if the client workstation is unable to access both the QuickMail
and the POP3 mail server.

■ You must login to the POP server prior to converting your mail. Logging in to QuickMail 
creates a required user directory.

■ If the CE Software folder is aliased to a remote volume, the Converter prompts you for yo
AppleShare password. If you choose to cancel the AppleShare dialog at the password pr
the Converter quits without displaying an alert dialog.

■ QuickMail LAN versions prior to 3.5 stored the QuickMail Stuff folder in the Preferences 
folder rather than the CE Software System folder. Consequently, the QuickMail Converter
not convert pre-QuickMail 3.5 files unless you use the following workaround.

CONVERTER DIALOG

Launch the QuickMail Converter application to display the Converter dialog. The Converter dialog is 
divided into four panes: QuickMail LAN login pane, QuickMail Pro login pane, the Conversion pa
and the Help/Progress pane. 

Figure 108: LAN to Pro Converter dialog

QuickMail Pro 
Login Pane

QuickMail LAN Login 
Pane

Conversion Pane Help/Progress 
Pane
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COMPLETING THE QUICKMAIL LAN LOGIN PANE

1 In the QuickMail LAN login pane, click the MailCenter button. A network browsing dialog appears

2 Select the Zone and QuickMail MailCenter where your LAN account is located and click OK. The 
Converter dialog displays with your Zone and MailCenter listed.

3 Click the Name button and select your name from the Select a Name dialog that appears. Click OK to 
return to the Converter dialog.

4 Type your LAN password in the Password field. Your password appears in bullets for added secur

COMPLETING THE QUICKMAIL PRO LOGIN PANE

1 Select your name from the Name field pop-up menu.

2 Type your QuickMail Pro password in the Password field. Your password appears in bullets.

THE CONVERSION PANE

Click which files you want converted from QuickMail LAN to QuickMail Pro.

▲ Warning : The QuickMail LAN Custom Dictionary overwrites your QuickMail Pro Custom Dictiona

An 01 is appended to files with duplicate names during the conversion. MailManager rules are not 
converted.

HELP/PROGRESS PANE

The Progress Pane displays help text for the Converter dialog. During conversion, this pane displays 
progress information.

CONVERTING YOUR FILES

After configuring your Converter dialog options, click Convert. The Convert button is not enabled until you 
have selected a LAN MailCenter and name, a QuickMail Pro name, and at least one type of file t
vert.

When you click the Convert button, a confirmation dialog appears.
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Figure 109: Confirmation dialog

➣ Important : Only Internet addresses (addresses with @) are converted. This is due to the fact tha
QuickMail Pro does not use MailCenter names or Zones when routing mail.

CONVERSION RESULTS

After the selected files are converted, a dialog displays a summary of the conversion results.

Figure 110: Conversion results

Now when you log in to QuickMail Pro, all your old filed mail, address books and groups, and form
at your fingertips!
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APPENDIX A:    HOW QUICKMAIL PRO WORKS

Have you ever wondered how an E-mail message can reach a recipient anywhere in the world us
a simple address, such as joe@acme.org? Message delivery over the Internet using TCP/IP relies on th
Domain Name System, a hierarchical structure that allows efficient identification of internetworke
computers, mapping domain names to unique IP addresses. This appendix provides an overview
process by which E-mail messages are routed and distributed over the Internet.

INTERNET MAILBOXES

The fast-growing phenomenon that we call the Internet is a world-wide collection of internetworke
computers. This internetwork is constructed so that it can be accessed by people using many dif
kinds of computers: Macintosh, Windows, DOS, UNIX, Linux, and others. A variety of protocols—
such as SMTP, POP3, FTP, and HTTP—provide different kinds of services on the Internet, indep
of computer platform. Mail services under SMTP and POP3 allow you to send mail to someone o
UNIX computer even if you compose and send the message from a Macintosh. Additionally, HTT
ports the exchange of Web pages and FTP allows file transfers, regardless of which computer pl
you are using.

People use several different methods to access the Internet: dial-up connections through telepho
direct leased lines, XDSL connections, cable modems, direct leased lines, or full-time network co
tions. E-mail delivery has been designed so that computers don’t have to be on the Internet contin
in order to receive mail. Instead, an E-mail server acts as the host, storing messages temporarily
mail users until they can log on and access their messages. Unlike some other kinds of services
Internet, E-mail transfers provide end-to-end acknowledgement, which ensures that the E-mail s
receiving the series of packets that make up a message communicates with the machine that se
message, acknowledging delivery.

People who use dial-up connections to access the Internet often rely on an Internet Service Prov
(ISP). Many ISPs are local companies that have a host, or server, directly connected to the Intern
purchase and maintain the servers, and their customers access the server for a monthly fee. Wh
use an ISP for Internet access, your account usually entitles you to one or more mailboxes on th
server. See Figure 112 on page 135.

Direct lines to the Internet are primarily used by businesses, schools, and universities that can af
purchasing and maintaining an Internet server and the accompanying hardware. Unlike a dial-up
nection, a direct line is always “live.” The path to the Internet is always open, so if you receive ma
ing the course of the day, the mail server can alert you immediately. For example, QuickMail Pro
flash an icon in your menu bar each time an incoming message is detected. 
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INTERNET ADDRESS

Numeric addresses can be difficult for humans to read, exchange, and remember. To help deal w
problem, the Domain Name System provides a method for organizing addresses, composed of l
into an enormous tree structure, referred to as a namespace. This hierarchical namespace make
to administer the system and the addresses within this tree can be represented as names instea
bers. 

The Domain Name System is structured so that the label is divided into higher level sections (su
such as com or net) and one or more lower level sections (such as libraryofcongress or harvard). Each 
sequence of labels maps to a unique IP address that identifies the host server. IP addresses are
structed using a series of decimal values separated by dots, such as 192.168.1.100. Because of 
tiveness of the Domain Name System, as an E-mail user you rarely have to deal with strings of nu
but you can use more recognizable words and phrases.

An Internet E-mail address consists of two parts: a local part, represented by the user name and the 
domain, which identifies a particular machine on which messages are being stored and transferred
two parts are separated by the character “@”. The address looks like: user@domain. Periods used to 
separate the parts of the address are generally called “dot.” For example, the address, president
house.gov is related as “president at whitehouse dot gov”. See Figure 111 for an illustration.

Figure 111: Parts of an E-mail address

The user name is a mail account mailbox. The domain is the section of the Internet that contains
mail server you use. 

The domain also includes your organization type. Common organization types include .gov (govern-
ment), .edu (universities), .com (commercial), and .mil (military). The high-level suffix can also repre-
sent a country, rather than an organization. In such a case, it is called a location code. Examples
location codes are .ca (Canada), .se (Sweden), and .pl (Poland). 

Internet addresses are read from right to left by Internet servers. Your mail is routed from one se
the next until it reaches the server that stores your mailbox. When you connect to your Internet m
QuickMail Pro retrieves your mail and places it in your Inbox.

president  @  whitehouse.gov

    user name

          user                             domain

organizationseparator   host
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MAIL TRANSPORTS

QuickMail Pro uses POP3 and SMTP as primary mail transports. 

POP3 PROTOCOL

There are several protocols, or languages, that have evolved with the growth of the Internet. One
most common electronic messaging protocol today is called the Post Office Protocol, version 3 (P
This protocol is popular because it is based on open standards. “Open standard” means the lang
used is not dependent upon a particular computer platform or operating system. The POP3 serve
“layer” of language that any computer can understand. This makes Internet and LAN communica
easier as open standards become more widespread.

Figure 112: POP3 protocol in action

You can connect to your POP account from client machines at home and work using QuickMail P
The POP3 server acts like a mailbox at the post office. When you log in to your E-mail account a
server, it is similar to checking your post office box for mail. Each time you make a connection, Q
Mail Pro checks for new mail and retrieves a copy of any new messages. After successfully retrie
messages, the client will either leave a copy of each message on the server (if the ISP allows thi
delete the server copy. Check with your ISP before choosing to leave mail on their server — man
viders limit the storage available for E-mail messages and restrict the amount of time mail can be
the server. 

SMTP

The Simple Mail Transport Protocol (SMTP) handles the task of transporting mail. Each mail clie
application relies on SMTP as the method and underlying protocol used when sending mail from
user to another. Components of SMTP also run on the mail hosts. SMTP server software is typic
installed on the same machine as the POP3 software and it is used most frequently over perman
work connections. 

POP account

Mac at home PC at work
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SECURITY

In response to security concerns over Internet communication, CE Software incorporated Authen
POP (APOP) into QuickMail Pro. APOP provides a level of security to ensure that passwords can
stolen when being transmitted across the Internet. 

When you login to QuickMail Pro, you’re also logging into your mailbox at the POP server. APOP
issues a timestamp when you login. QuickMail Pro records this timestamp and issues encrypted
mation based on the timestamp and your password. When the server receives the APOP comma
verifies the encryption string. If the string is correct, the POP3 server issues a positive response a
mail session begins.
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APPENDIX B:    TROUBLESHOOTING

Occasionally you may have some difficulty connecting to the Internet. This section helps you trou
shoot common problems with your ISP or your network administrator. If you are having a problem
that’s not discussed in this section, visit the CE Software Technical Support Web page at 
http://www.help.cesoft.com/.    

Table 2:   General troubleshooting tips.

The Problem The Possible Solution
Your messages are returned to 
you unsent.

Verify the address and send the message again.

The modem doesn’t connect. Verify the modem setting matches the kind of modem you are
using. Try the Hayes compatible setting.

Redial. Some times a poor connection or a bad line causes 
intermittent problems.

Check with your ISP to verify the server is running. 

Verify the phone number in your dial-up connection. 

If you are in a building that requires dialing “9” to get out, you may have left 
“9” out of your dial-up phone number.

Disable “call waiting” for your phone line.

Check your Internet connection software documentation.

Verify the correct Connection Script is selected.

Your message did not send. Check your modem connection.

Verify you have entered your POP account and password for your ISP 
account correctly in the QuickMail Pro login screen.

Verify the correct Connection Script is selected.

You have received an error message from 
your ISP.

Talk with the ISP’s technical support staff.

A message was sent more than once. Some ISPs have a mail recipient limit. As a result, the message may be 
sent repeatedly until all addressees receive a copy.

You can’t receive mail. Check your Return Address field in the Account panel of the Preferences 
window. If you have more than one mailbox account at your ISP, you may be 
looking in the wrong one.

You can’t launch http addresses. Set Internet Config Helpers preferences.
Make sure you restart your machine after installation.

The text of incoming messages come into 
my Inbox as enclosures.

If a message has more than 28Kb of text in the message body, the text is 
placed in an enclosure.

When you retrieve mail from both work and 
home (with the “Leave mail on server until 
deleted” preference selected on both com-
puters), you discover that you are retriev-
ing duplicate messages.

“Leave mail on server” copies messages to your Inbox and leaves original 
messages on the server until you remove them with QuickMail Pro. To 
remove messages that have accumulated on the POP3 server, deselect this 
preference, select “Verify Inbox” from the Tools menu, delete items you have 
previously read, and select Empty Trash from the File menu.
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GLOSSARY
APOP—Authenticated POP. An E-mail login 
method that sends passwords over the Internet in 
a secure manner.

AppleDouble—Coding format specified by 
Apple. Both the resource fork and the data fork 
are transmitted.

AppleSingle—Coding format specified by 
Apple. Both the resource fork and the data fork 
are transmitted. This coding format requires 
MIME, or it needs to be combined 
with uuencode.

AppleScript—Scripting language that enables 
Macintosh users to automate actions through 
scripts incorporated into software.

ASCII —American Standard Code for 
Information Interchange. The standard for the 
codes used by computers to represent the 
upper- and lower- case Latin letters, numbers, 
punctuation, etc.

Base-64—A robust encoding method designed to 
preserve an E-mail message as it passes through 
E-mail gateways.

Baud Rate—The rate at which data 
transmission takes place using a modem.

BBS—Bulletin Board Services. An electronic 
posting of mail and files for users to share and 
exchange. A common example of such a system 
is CompuServe.

binary—1: The numbered system with 2 as its 
base; the numbers within the system are 0 and 1. 
Computer languages are written in binary. 2: A 
file that contains data that is not text.

Binhex—Binary Hexadecimal. A method to con-
vert non-text files into ASCII. This is 
necessary because Internet E-mail can only 
handle ASCII.

Data-only—Sends only the data fork of enclosed
files while still coding the message according to
MIME specifications.

Directory Service—A global electronic White 
Pages service that allows network users to 
retrieve addresses.

domain—1: The part of an Internet address to th
right of the “@” symbol. 2: A logically-related 
collection of networked machines.

DNS—Domain Name Service. Converts a 
domain name to an IP (Internet protocol) 
number that can be understood by computers o
the Internet. 

Firewall—Security software that restricts acces
to a computer network.

FTP—File Transfer Protocol. An Internet 
standard protocol used to transfer files from one
computer to another.

header—The portion of a message that contain
the source and destination addresses.

host—Any computer on a network that is a 
depository for services available to other 
computers on the network.

hosts file—A text file that contains IP addresses
and domain names. Hosts files are necessary o
networks that do not have access to a DNS.

http—HyperText Transport Protocol. The 
language for transferring files across the Interne

hypertext—Any text that contains links to other 
documents or words.

Internet—A global computer network used for 
communications such as E-mail and file transfe
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Internet Config—A Public Domain utility 
QuickMail Pro uses for launching URLs and 
mailto messages.

Internet Service Provider (ISP)—An 
organization that provides a connection between 
your computer system and the Internet. 

intranet—An internal “Internet” that’s typically 
only accessible to users within a network firewall. 
Users with access to the Intranet can browse 
company information posted on the Intranet.

LAN —Local Area Network. The local cabling 
and protocol network upon which workstations 
and servers reside. Local Area Networks become 
Wide Area Networks (WAN) when they utilize 
transport services other than those provided in the 
LAN. For example, using intermittent, 
long-distance phone lines to connect two sites 
rather than the physical cabling used for LANs.

LDAP—Lightweight Directory Access 
Protocol. A directory service protocol used to 
query public and private directories for E-mail 
addresses and other information.

mailhost—A computer links all users within a 
domain to the Internet. The network mailhost 
must be exposed to the Internet and the MX 
Record must point to it.

mail server—The computer that handles the dis-
tribution of E-mail.

MIME —Multipurpose Internet Mail 
Extension. A standardized format for Internet 
E-mail that sends multimedia and binary data 
without modifying files.

MX record—A resource record used by DNS to 
specify a mail exchanger for a domain name. It is 
a single record type that replaces MF (mail 
forwarder) records and MD (mail destination) 
records.

newsgroups—News is a service on the 
Internet, and can be compared to a very large 
bulletin board divided into different segments 
called newsgroups. The participants may read 
and write articles in these newsgroups.

node—A single computer connected to 
a network.

non-text message—Contains images, sound, 
applications, etc.

notification—QuickMail Pro notifies the user 
when mail arrives in the Inbox. Depending upon
user–set preferences, notification is audible, 
visual or both.

persona—an identity represented by a specific 
POP3 return E-mail address, signature, and co
tact data. QuickMail Pro lets you create a numb
of personas for each individual E-mail account.

POP—Post Office Protocol. A computer 
language based on open standards, so the 
language is not dependent upon computer 
platform or operating system. It is a “layer” of 
language that any computer can understand.

PPP—Point to Point Protocol. Allows a 
computer to connect to the Internet over a dial-u
phone line. 

protocol—A standardized way (a set of rules) to
exchange information between different 
machines. These rules specify the messages th
each machine can send and receive. They also
control the order in which messages must be sen
PPP, SLIP and TCP/IP are examples of protoco

RFC822 standard—A message 
representation protocol. 

server—A computer with specialized server soft
ware running on it. “POP server” refers to the 
computer running the POP3 software.
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SMTP—Simple Mail Transfer Protocol. SMTP 
is high level protocol that works on a layer of 
transmission level protocols.

TCP/IP—Transmission Control Protocol and 
Internet Protocol. A layer of protocol widely used 
in the Internet. TCP/IP is often the transmission 
layer under SMTP.

uuencode—Commonly used method to encode 
files prior to sending them between incompatible 
computers.

URL—Uniform Resource Locator. A standard 
method for giving the address of a resource on 
the World Wide Web (WWW). A URL looks like: 
http://www.cesoft.com.

WAN—Wide Area Network. A LAN becomes a 
Wide Area Network when it uses transport
services other than those provided on the LAN.

WWW —World Wide Web. The part of the Inter-
net containing documents and graphics which are 
viewed using browsers.
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	Figure 10: Message Browser window
	Viewing Hot Help
	Figure 11: Hot Help on the button bar


	Creating and Sending a Message
	1 Launch the QuickMail Pro application from its folder, from the Apple menu, or from the QM Pro M...
	2 Select New in the File menu and then choose Message to display a new message window.
	3 Type the E-mail address of the recipient into the To field (directly below the Sender field). C...
	4 Enter a Subject for the message onto the Subject line (as shown in Figure�12).
	5 Type the message contents into the Message body area of the form. You can also select a differe...
	Figure 12: The Message Window

	6 Click the Send button.
	Figure 13: Main Address Book

	7 Your message is stored in the Outbox until the next scheduled mail delivery time arrives or unt...
	Scheduling Your Connections
	1 Select Preferences in the Configure menu.
	2 In the User panel, select the Accounts option.
	3 Double-click the account you want to edit.
	4 Click the Edit button to access the account information. The Edit Account dialog appears.
	Figure 14: Setting the interval to check mail

	5 In the Incoming Mail options, check the box labeled Check mail... and enter the number of minut...
	6 Click OK to save the new values.

	Using Quicksend
	1 Select c-Ctrl-S (or the HotKey combination you have assigned) to open the QuickSend form.
	2 Type and address your message. See“Addressing Messages” on page�20.
	3 Click Send.

	Assigning a Message Priority
	1 Compose a new message.
	2 Address the message to the intended recipient.
	3 Click the priority button located to the right of the message address field, as shown in Figure...
	Figure 15: Message priority options

	4 Use the Send button to route the message to the Outbox.

	Using Return Receipts
	Figure 16: Return receipts

	Bad Address Notification
	Unsending Messages
	1 Open the Sent Items folder in the Message Browser.
	2 Select the message you want to unsend and select Unsend from the Message menu. The instruction ...
	3 Click the Check Mail button in the Message Browser to immediately submit your request to unsend...
	4 The next time you check mail, a message appears in your Return Receipt folder indicating whethe...
	Figure 17: An unsend receipt for multiple recipients



	Addressing Messages
	Typing the Address
	Type To Feature

	Using the Show Address Dialog
	1 Click the New Message button in the Message Browser.
	2 Click the Show Address Dialog icon (the small face to the left of the address header). The curr...
	Figure 18: Selecting contacts from the address book

	3 If the current address book or directory server is not the one that you want to view, make a ne...
	4 Identify recipients from the list, using the tabbed letters to display the starting letter to i...
	5 Choose recipients from the list in one of these ways:
	6 You can move recipients between the TO:, CC:, and BCC: panes, as needed, or delete a name by hi...
	7 When you have completed filling in the address panes, click Send to route the message to the in...

	Delaying Message Delivery
	Using The Delay Feature
	1 Complete a new message and then select the Show Address Dialog button.
	2 Select the recipients for the message and then click the Delay button. The Delay Send dialog ap...
	Figure 19: Delay Send dialog

	3 Select a date using the Do not deliver message until field.
	4 Choose a time for the message delivery.
	5 Click OK to confirm your choices. QuickMail Pro completes the message delivery according to the...

	Using the Drafts Folder
	1 Create a message and begin typing in the subject line and body of the Message window that appears.
	2 Click the Save As Draft button in the Message window. The incomplete message is immediately sav...
	The Templates Folder
	1 Create a message and begin typing in the subject line and body of the Message window that appea...
	2 Click the Save As Draft button in the Message window. The “canned” message is immediately saved...
	3 Open the Drafts folder and drag your message to the Templates folder.
	4 Click and hold the New button in the Message Browser. The message you just placed in the Templa...



	Setting Mailer Encoding Preferences
	Figure 20: Preferences dialog
	Figure 21: Edit Mailer Encoding dialog

	Encoding Options
	Text Encoding
	Attachment Encoding
	Table 1: Selecting message encoding options


	Working with Address Books in the Contacts Manager
	Figure 22: Sorting contacts
	Contacts Manager Buttons
	Address Book Field Selections

	Adding New Contacts
	1 Click the New Contact button to display the New Contact dialog.
	Figure 23: New Contact dialog

	2 Enter the first and last name of the recipient in the First and Last text fields. You can also ...
	3 Enter the E-mail address of the recipient in the E-mail field. For example: susan@isp.com.
	4 Optionally, you can enter individual personal information about contacts, such as their title, ...
	5 Select the E-mail tab and enter any additional E-mail addresses for the contact. You can highli...
	6 Select the Mailer Encoding setting to use for enclosures from the drop-down list. If you have r...
	7 The Phone, Location, and Notes tabs let you record more information about each contact, includi...
	8 Once you have completed adding information for the contact, close the New Contact dialog. Quick...
	Figure 24: Saving contact data

	9 If you have multiple address books, you can select the one in which to store the new entry. Cli...
	Dragging Names to the Message Window
	Mail Settings
	1 The Email tab for each person’s contact data contains a Mailer Encoding selection offering the ...
	Figure 25: Mailer encoding options




	Sending Attachments
	Selecting an Attachment File
	1 Create a message and click the Add or Save Attachments icon to the left and below the message a...
	Figure 26: Attachment options

	2 Click the Add Attachment option to access the Open File dialog.
	Figure 27: Open File dialog

	3 Navigate through your folders until you locate a file that you want to attach. The Show Preview...
	Figure 28: Attachment on the message form

	4 Repeat this process if you want to add additional files. Each new attachment will be added to t...
	5 Click the Send button when you’re ready to transmit the message. The attachments will be encode...

	Adding Voice Attachments
	1 Click the New button in the Message Browser.
	2 Click the Add and Save Attachments icon and select Record Sound from that list that appears. Th...
	Figure 29: Recording sound

	3 Speak to test your microphone. If you see sound waves next to the speaker icon, your microphone...
	4 Click Record and speak into your microphone. The amount of time available to record is shown un...
	5 Click Play to hear your message.
	6 Click Save to add the voice attachment to the QuickMail Pro message. The attachment is shown as...
	Figure 30: Sound attachments



	Address Books
	Creating a Local Address Book
	1 Select Address Books in the Configure menu. The Address Books dialog appears.
	Figure 31: Creating a local address book

	2 Click the Add Local button. The Add Local Address Book dialog appears.
	Figure 32: Add Local Address Book dialog

	3 Enter a name for the Address Book.
	4 If you want this Address Book to be scanned for matches when you are manually entering an addre...
	5 Click OK when done to create your new Address Book.
	6 Add contacts to your new Address Book, as described on “Editing Users in Address Books” on page...
	7 You can return to the Address Book dialog and rename any Address Book listed by using the Edit ...

	Creating a Remote Address Book
	Searching for Remote Address Books
	1 Select Address Books in the Configure menu. The Address Books dialog appears.
	Figure 33: Creating a remote address book

	2 Click the Add Remote button. The Add Remote Address Book dialog appears.
	Figure 34: Add Remote Address Book dialog

	3 Click Find remote address books on directory server in the Add Remote Address Book dialog and c...
	Figure 35: Find Remote Master Address Books dialog

	4 Select a directory server from the Directory Server pop-up menu and click Find. The status line...
	5 If the search locates a master address book, it is displayed in the Found address books area of...
	6 Click OK in the Find Remote Master Address Books dialog when you are finished. The Address Book...
	7 Click OK in the Address Books dialog when you are done making changes to your list of Address B...

	Manually Adding Remote Address Books
	1 Select Address Books in the Configure menu. The Address Books dialog appears.
	Figure 36: Creating a remote address book

	2 Click the Add Remote button. The Add Remote Address Book dialog appears.
	Figure 37: Add Remote Address Book dialog

	3 Click Add manually in the Add Remote Address Book dialog and click OK. The Remote Master Addres...
	Figure 38: Remote Master Address Book Properties dialog

	4 Type a name for the Address Book in the Name field.
	5 Type the address of your LDAP server in the Host field.
	6 Type the syntax necessary for LDAP queries in the Fetch filter field.
	7 Select an authentication option and click OK. The Address Books dialog appears.
	8 Click OK in the Address Books dialog when you are done making changes to your list of Address B...


	Creating a Local Group
	1 Select New from the File menu and choose Local Group. The Local Group dialog appears.
	Figure 39: Group dialog

	2 Enter a name for the Group. You can also enter any other information about the Group on the Not...
	3 Click the Members icon to access the current Address Book in Contacts Manager. The list of grou...
	Figure 40: List of group members

	4 After you add members to the new Group, close the dialog. QuickMail Pro prompts you to choose a...
	Figure 41: Choosing an address book

	5 Select one of the displayed Address Books and click Save. The Group you have created will be sh...

	Creating an Organization
	1 Select New and then Organization from the File menu. The Organization dialog appears.
	Figure 42: Organization data

	2 Fill in the basic contact information in the Organization tab.
	3 Enter any additional details in the Phone, Location, and Notes tabs.
	4 Close the dialog when done. The Save As dialog lets you choose the Address Book in which the or...

	Editing Address Books
	1 Select Address Books in the Configure menu to display a list of the currently defined Address B...
	2 Select the name of the Address Book to edit.
	3 Click OK when done.

	Editing Users in Address Books
	1 Select the Contacts Manager option from the Window menu. The contents of the current address bo...
	2 Choose a view for displaying the contacts. For example, you might choose Persons from the Show ...
	Figure 43: Choosing a contacts view

	3 Double-click the name of the contact that you want to edit. The Person dialog appears.
	Figure 44: Editing fields for a person

	4 Make any necessary changes to the entries on the individual tabs. Close the dialog when done.
	5 QuickMail Pro prompts you to save the changed data. Click Save to store the new information or ...

	Subscribing to a Mailing List
	1 Select New and then Mailing List from the File menu. The Mailing List dialog appears.
	Figure 45: Subscribing to a mailing list

	2 Enter the identifying information that you need for the mailing list.
	3 On the URL tab, enter the address that is used to subscribe to the mailing list in the field la...
	4 Return to the Mailing List tab and click the Subscribe button. QuickMail Pro completes the conn...
	5 Close the dialog when done. Choose an Address Book from the dialog that appears for storing the...

	Importing Addresses
	1 From the File menu, select Import and then choose Contacts as text file. The Choose a File dial...
	2 Locate the folder containing the file that you want to import. You can use the Show Preview but...
	3 When you have located the appropriate file, click Choose. The contact information must be a tab...
	Figure 46: Contacts Import Order dialog

	4 Click and drag the Available Fields titles on the right side of this dialog to match them with ...
	5 Select an Address Book as a target for the import operation. You can also create a new address ...
	6 To verify the imported data, select the Choose Address Book button in the Contacts Manager and ...

	Importing Other Types of Address Files
	1 From the File menu, select Import and then choose the appropriate option: Contacts as LDIF file...
	2 Locate the folder containing the file that you want to import. You can use the Show Preview but...
	3 When you have located the appropriate file, click Choose.
	4 Select an Address Book for the import operation.
	5 QuickMail Pro displays the progress as the file is being imported. When the operation is comple...

	Exporting Addresses
	1 From the File menu, choose Export and then Contacts as Text File.
	2 Make a selection from the Choose Address Book dialog that appears. Click OK to confirm your sel...
	Figure 47: Contacts Export Order dialog

	3 Select the data items from the Available fields column that you would like to include in the ex...
	4 Click and drag to adjust the order of the data items as they appear in the Export order column....
	5 Click Export. A standard dialog prompts for a destination file. When you export the file nothin...

	Exporting Addresses to LDIF Format
	1 From the File menu, choose Export and then Contacts as LDIF File.
	2 Make a selection from the Choose Address Book dialog that appears. Click OK to confirm your sel...
	3 Choose a destination folder and a file name for the export operation. By default, the .LDIF ext...
	4 A progress indicator displays while the export operation is taking place.
	5 When the operation is complete, you can exchange the LDIF file that was created and the file co...


	Directory Services
	LDAP Support
	Configuring Directory Servers
	1 Select Directory Servers in the Configure menu. The Directory Servers dialog appears. A list of...
	Figure 48: Directory Servers dialog

	2 To configure an additional directory server, click the Add button. The Add Directory Server dia...
	Figure 49: Add Directory Server dialog

	3 Enter the Name and LDAP settings for the server. The Host field specifies the LDAP domain name ...
	4 The Default Port for LDAP access is 389, but you can override this default value by checking th...
	5 Enter any search limitations, such as the Max Hits retrieved during queries and the Timeout val...
	6 Choose an authentication option from the three available selections.
	7 Click OK to save your changes and return to the previous display.

	Editing Directory Server Entries
	Figure 50: Edit Directory Server dialog
	1 Complete the Edit Directory Server dialog to add or edit private or public LDAP directories.
	2 Click OK in the Edit Directory Server dialog to complete the changes and return to the previous...

	Using LDAP
	Basic Search
	1 Click the Contacts button in the Message Browser window. Contacts Manager opens the current add...
	2 Click the Directory Server icon. The directory query screen appears.
	Figure 51: LDAP search options

	3 Complete the search criteria using the drop down list box selections to determine the search te...
	4 Click and drag an address from the search results to the address pane of the Message window. Yo...




	Checking Your Spelling
	1 Open a message and click the Spell button. QuickMail Pro scans for misspelled words. When text ...
	2 The spelling checker pauses and offers suggestions when it encounters an unknown or misspelled ...
	Figure 52: Spelling dialog

	3 Click Replace to substitute a suggested spelling for the term displayed.
	4 Click Ignore to bypass the flagged word and to continue the check.
	5 Close the dialog to return to the Message Window. Any changed words or dictionary modifications...

	Selecting a Dictionary
	Standard Dictionary
	Selecting Dialects
	1 Click Options to display the Dialects dialog.
	Figure 53: Dialects dialog

	2 Select the checkbox that applies to your dialect.
	3 Click OK to apply your selection.


	Using Stylized text
	Figure 54: Stylized text
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	Figure 55: The Message Window

	Managing Inbox Mail
	Retrieving Mail
	Notification

	Reading Messages
	Message Peek
	Figure 56: Message Peek


	Forwarding Messages
	1 Open a message that you received and choose Forward from the Message menu, or click the Forward...
	Figure 57: Mail Forward options

	2 Choose the option that applies to the message that you want to forward. With Changes includes a...
	3 If you have elected to “forward with changes,” you can type any comments or notes into the mess...
	4 Click the Contacts button and select one or more recipients from the Address Book or Directory ...
	5 Click Send to route the message to the indicated recipients.

	Replying to Messages
	1 Click the Reply button in an open message. The Reply To dialog appears if the message includes ...
	Figure 58: Reply To options

	2 Select one of the Reply To options and click OK.
	3 The Reply form displays the original message with a flashing cursor to mark the point where you...
	Figure 59: Reply with quoted text

	4 Type your reply and click Send.
	Saving the sender’s Address
	Figure 60: Person dialog
	Dragging the Sender’s Address
	1 Open a message from any of the folders in your Message Browser.
	2 Open the Contacts Manager and select the Address Book in which you want to save the sender’s ad...
	3 Click on the person icon beside the sender’s address and drag the person icon to the listings a...
	4 Close the Address Book and confirm the changes by clicking the Save button.



	Printing Messages
	Showing Internet Headers
	1 Highlight a message in the Message Browser.
	2 Select Show Internet Headers from the Message menu. The header contents appear in a separate wi...
	Figure 61: Show Internet Header window

	3 Click OK when done viewing the header.

	Moving Messages to Trash
	Emptying Trash

	Saving Messages as Text
	1 Open a message.
	2 Select Save as in the File menu. The standard Save As dialog appears.
	Figure 62: Saving a message as text

	3 Ensure that the File Format is set to Text Document.
	4 Make any necessary changes to the name for the file and specify a destination for it.
	5 Click Save.

	Filing Messages
	1 Select a message to file in the Message Browser. Click the File button to display the File Mess...
	Figure 63: File Message dialog

	2 Select a folder and click File. My Filed Mail may be your only option if you haven’t created an...
	3 A filing status bar appears briefly and your message is filed in the folder you selected.
	Nesting Folders

	Streamlined Message Handling
	Figure 64: Buttons that support drag and drop

	Marking Messages
	1 Select one or more messages in the Message Browser.
	2 Open the Message menu and choose the appropriate marker from the options shown in Figure�65.
	Figure 65: Message markers

	3 You can reverse any marker assignments by returning to this menu and selecting the opposite cho...
	Flagging a Message
	Deleting a Group of Messages
	1 Highlight the individual messages that you want to delete
	2 Open the Message menu and select Mark as Deleted.
	3 From the Tools menu, select Purge Deleted Messages. The messages marked for deletion will be pe...


	Retrieving Large Messages
	1 Highlight the message in the Message Browser list.
	2 Select Retrieve Large Message from the Message menu.


	Configuring Shared Mailboxes
	1 Select Shared Mailboxes from the Configure menu. The Shared Mailboxes window appears.
	Figure 66: Message markers

	2 Click the Update List button. If your mail administrator has set up a shared mailbox, it appear...
	3 Click the shared mailbox to which you want to subscribe and click the Subscribe button. The inf...
	4 Click OK when you are finished. Next time you open the Message Browser, your shared mailbox wil...

	Managing Mail Folders
	Creating a Mail Folder
	1 Open the File menu and select New and then Personal Folder. The New Folder dialog appears.
	Figure 67: New Folder dialog

	2 Enter a name for the new folder in the name field.
	3 Click the Folder icon if you want to assign a particular icon to correspond with the newly crea...
	Figure 68: Icon Picker dialog

	4 Highlight an icon to use for the folder and click OK.
	5 Click New to create the folder. The folder and its corresponding icon will appear in the Person...


	Finding Text in Messages
	1 Open a QuickMail Pro message.
	2 Select Find in the Edit menu or press c-F.
	Figure 69: Find dialog

	3 Enter text in the Find field. You can search for any text, word or group of words up to 255 cha...
	4 Click Find to scan all fields within a message.

	Receiving Attachments
	Incoming Attachments
	Retrieving an Attachment
	1 Open a message that contains an attachment.
	Figure 70: Message with an attachment

	2 Click the drop-down arrow next to the Attachment icon to display the file type and size of the ...
	3 Click the Attachments icon to display the available options for handling the attachment. A menu...
	Figure 71: Attachment options

	4 To save the attachment as an external file, select the Save Attachment option. QuickMail Pro sa...
	5 Close the message window when done.

	Launching Attachments
	1 Open the message and display the list of attachments.
	2 Double-click the attachment you want to launch.
	3 If you have the application in which the file was created, or an equivalent application, the pr...


	Listening to Voice Mail Attachments
	Playing Voice Mail
	1 Open the message. If autoplay is selected in the Preferences, the voice mail will play as soon ...
	2 Highlight an attachment marked with the speaker icon in the list. Select Play Sound from the At...
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	Advanced Options
	Mailer Encodings
	Figure 88: Mailer Encodings panel
	Using the Compatible Encoding for Mac Files
	Figure 89: Macintosh file format compared to PC/UNIX format

	Adding an Encoding Setting
	1 From the Mailer Encoding panel of the Preferences window, select Add. The Add Mailer Encoding d...
	Figure 90: Add Mailer Encoding dialog

	2 Enter a name for the Encoding method. This is the name that will appear in the Mailer Encoding ...
	3 Select a Form Encoding to use if intended recipients are QuickMail Pro users. The QuickMail Pro...
	4 Set the characteristics of the Text Encoding. You can select either HTML text or Plain Text, an...
	5 Choose a Byte Encoding method for text, which determines what method of storage and compression...
	6 Select a File Format to use for attachments. These file formats enable attachments containing b...
	7 Choose a Byte Encoding method for attachments. This selection should be compatible with a metho...
	8 Click OK when done to save your selections and create a new Mailer Encoding entry.


	Mailer Mappings
	Figure 91: Mailer Mappings
	Adding Mailer Mappings
	1 From the Mailer Mappings panel, click the Add button. The Add Mailer Mapping dialog appears.
	Figure 92: Add Mailer Mappings

	2 Choose whether the Mailer Mapping is to be based on the X-Mailer Header Field (which is extract...
	3 Enter the pattern that you want QuickMail to recognize. You can use the wildcard character (*) ...
	4 Choose the Mailer Encoding method that you want to associate with this Mailer Mapping. QuickMai...
	5 Click OK when done to create the new mapping.


	Pager & Fax
	Figure 93: Pager and Fax options
	Chapter 5:� Search Options


	Starting a Search
	1 Click the Find option from the Edit menu. Or, select the Search button from the Message Browser...
	Figure 94: QuickMail Search dialog

	2 Choose the folders to include in the search in the Find messages in pop-up menu.
	3 Choose the criteria to apply to the search in the matching pop-up menu.
	4 Specify the actual part of the message to search using the pop-up menu on the next line. For ex...
	5 If you want to add an additional item to search, click the More button.
	Figure 95: Searching through message text

	6 Click Find to start the search. The search results appear in the Browse pane, where they can be...
	Improving Your Search Results
	Find Messages In
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	Figure 96: Selecting folders to search

	Selecting Criteria
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	Figure 97: More search choices


	Search Results Dialog
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	Configuring Mail Manager
	Figure 99: QuickMail MailManager window
	Creating Client Rules
	1 Select MailManager in the Tools menu to display the QuickMail MailManager window shown in Figur...
	2 Select Client Rules from the Rule Set pop-up menu.
	3 Click the New button. The Rule Properties dialog appears.
	Figure 100: Rule properties dialog

	4 Type a name for the rule in the Rule Name field. For example, type Rule #1 at the prompt.
	5 Select the Incoming, Outgoing, or Manual checkbox to specify when you want the rule applied.
	6 Specify the criteria messages must meet before MailManager processes them. You can expand the c...
	7 Click the Stop processing more rules checkbox if you want MailManager to stop processing rules ...
	8 Click the Add button when you are finished specifying the criteria for the rule. The Client Act...
	Figure 101: Client Action window

	9 Choose an action for the rule and specify any additional information the selected action requir...
	10 Click OK when you are done selecting an action. The defined action appears in the Rule Propert...
	11 Specify any additional actions you want the rule to perform by clicking the Add button and sel...
	12 When you are done specifying the actions that apply to the rule, click the close box in the Ru...
	13 Click Save at the prompt to save the rule you just created. The new rule appears in the QuickM...
	14 Click the Start Client Rules check box to enable the rules you have created.
	Client-Based Criteria
	Any Criteria
	All Criteria
	All Messages
	Address
	Subject
	message text
	date sent
	priority
	status
	folder name
	MailManager

	Client-Based Actions
	1 Click the Recipient List button. The Contacts Manager appears
	2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.
	3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard.
	4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again ...
	5 Click in the address field and paste the address from your clipboard.
	6 Type the message text you want to include in the forwarded message in the Forward Text field.
	7 Click OK when you are done.


	Creating Server Rules
	1 Select MailManager in the Tools menu to display the QuickMail MailManager window shown in Figur...
	2 Select Server Rules from the Rule Set pop-up menu.
	3 Click the New button. The Rule Properties dialog appears.
	Figure 102: Rule properties dialog

	4 Type a name for the rule in the Rule Name field. For example, type Rule #2 at the prompt.
	5 Select the Incoming, Outgoing, or Manual checkbox to specify when you want the rule applied.
	6 Specify the criteria messages must meet before MailManager processes them. You can expand the c...
	7 Click the Stop processing more rules checkbox if you want MailManager to stop processing rules ...
	8 Click the Add button when you are finished specifying the criteria for the rule. The Server Act...
	Figure 103: Server Action window

	9 Choose an action for the rule and specify any additional information the selected action requir...
	10 Click OK when you are done selecting an action. The defined action appears in the Rule Propert...
	11 Specify any additional actions you want the rule to perform by clicking the Add button and sel...
	12 When you are done specifying the actions that apply to the rule, click the close box in the Ru...
	13 Click Save at the prompt to save the rule you just created. The new rule appears in the QuickM...
	Server-Based Criteria
	Any Criteria
	All Criteria
	All Messages
	Address
	Subject
	message text
	date sent
	priority
	status
	folder name
	MailManager

	Server-Based Actions
	1 Click the Recipient List button. The Contacts Manager appears
	2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.
	3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard.
	4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again ...
	5 Click in the address field and paste the address from your clipboard.
	6 Click OK when you are done.
	1 Click the Recipient List button. The Contacts Manager appears
	2 Double-click the recipient in the Contacts Manager. The Contact dialog appears.
	3 In the Contact dialog, highlight the E-mail address and copy it to your clipboard.
	4 Close the Contact dialog and the Contacts Manager. The MailManager Forward dialog should again ...
	5 Click in the address field and paste the address from your clipboard.
	6 Type the message text you want to include in the forwarded message in the Forward Text field.
	7 Click OK when you are done.



	Turning Rules On and Off
	Disabling Individual Rules
	1 Open the Rule Properties dialog (shown in Figure�102).
	2 Clear the Incoming, Outgoing, and Manual check boxes.
	3 Click the Rule Properties close box and click Save at the prompt. The rule you disabled will no...

	Disabling All Client or Server Rules
	Using the Tools Menu
	Using the QuickMail MailManager Window

	Processing Messages
	1 Highlight the messages you want to process.
	2 Select Apply Rules in the Tools menu. The message list is processed according to the currently ...


	Editing MailManager Rules
	1 Select MailManager in the Tools menu to display the QuickMail MailManager dialog.
	2 Select a Rule Set from the pop-up menu.
	3 Select a Rule and click Edit to display the Rule Properties dialog.
	Figure 104: Rule properties dialog

	4 If necessary, edit the criteria for the rule.
	5 If necessary, click the Add button to change the action for the rule. Click OK when you are don...
	6 Click the Rule Properties dialog’s close box and click Save at the prompt to store the edits th...
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	QuickMail Networker
	1 Select QM Pro Networker from the Macintosh Application menu.
	2 From the File menu, select Send Mail Now. Or, press the c-S keys. Networker sends any messages ...
	1 Select QM Pro Networker from the Macintosh Application menu.
	2 From the File menu, select Check Mail Now. Or, press the c-M keys. Networker transfers any inco...
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	Figure 108: LAN to Pro Converter dialog
	Completing The QuickMail LAN Login Pane
	1 In the QuickMail LAN login pane, click the MailCenter button. A network browsing dialog appears.
	2 Select the Zone and QuickMail MailCenter where your LAN account is located and click OK. The Co...
	3 Click the Name button and select your name from the Select a Name dialog that appears. Click OK...
	4 Type your LAN password in the Password field. Your password appears in bullets for added security.

	Completing The QuickMail Pro Login Pane
	1 Select your name from the Name field pop-up menu.
	2 Type your QuickMail Pro password in the Password field. Your password appears in bullets.
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